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Preface

Scope

This manual describes the operation of the General DataComm TEAM 521A software applic
The information contained in this manual has been carefully checked and is believed to be e
reliable. However, as General DataComm improves the reliability, function, and design of th
products, it is possible that information may not be current. Contact General DataComm if y
require updated information for this or other General DataComm products.

General DataComm, Inc.
Technical Publications
Park Road Extension
Middlebury, Connecticut, USA  06762-1299
Tel:   1 203 758 1811 Toll Free:   1 800 794 8246

Using This Manual

This manual is divided into the following chapters: 

• Chapter 1 -  System Description 

• Chapter 2 - Operation 

• Chapter 3 - Configuration 

• Chapter 4 - Maintenance and Diagnostics

• Chapter 5 - NMS 520 

• Chapter 6 - NMS 510 

This manual should be read in its entirety and all procedures completely understood before
installing or operating the unit. The notes that appear throughout this manual must be read p
any installation or operating procedure. Examples of notes are shown below.

Note A note provides essential operating information not readily apparent which you should be 
particularly aware of. A note is typically used as a suggestion.

Important Indicates an emphasized note. It is something you should be particularly aware of; 
something not readily apparent. Important is typically used to prevent equipment dama
076R154-V400 GDC TEAM 521A Version 4.0.0 vii
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Service Support and Training
VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment. VITAL 
Network Services provides hands-on training courses through VITAL Network Services Global 
Technology Training Services. Courses range from basic data communications, modems an
multiplexers, to complex network and ATM systems. Training courses are available at our ce
in the US, UK, France, Singapore and Mexico, as well as at a customer’s site.

For more information VITAL Network Services or for technical support assistance, contact VI
Network Services at:

VITAL Network Services World Headquarters
6 Rubber Avenue Telephones: Faxes:
Naugatuck, Connecticut 06770 USA 1 800 243 1030 1 203 723 5012

1 888 248 4825 1 203 729 7611
http//www.vitalnetsvc.com 1 203 729 2461

VITAL Network Services Regional Sales and Service Offices:

North American Region Office
6 Rubber Avenue
Naugatuck, Connecticut 06770 USA
Telephones: 1 800 243 1030

1 888 248 4825
1 203 729 2461
1 800 361 2552 (French Canadian)

Training: 1 203 729 2461
Faxes: 1 203 723 5012

1 203 729 7611

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico D.F., Mexico

Telephone: 52 5 645 2238
Training: 52 5 645 2238
Fax: 52 5 645 5976

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF UK

Telephone: 44 1189 657200
Training: 44 1189 657240
Fax: 44 1189 657279

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore 238880

Telephone: 65 735 2123
Training: 65 735 2123
Fax: 65 735 6889
viii GDC TEAM 521A Version 4.0.0 076R154-V400
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Chapter 1:  System Description

Introduction to TEAM 521A
This manual describes how to operate TEAM 521A software applications for configuring an
controlling the operation of SpectraComm 521A  and SpectraComm 521A/S Data Service U
(DSUs).  Both types of DSUs operate in the same manner with the exception that the SC 52
product provides a Sealing/Simplex current. Throughout this document, all information relat
both types of DSUs except where noted. A working knowledge of HP Open View and DSU 
functioning is assumed.

SpectraCommm 521A DSU Overview

The SC 521A DSU is a DATAPHONE Digital Service (DDS) compatible DSU that is intende
be used in central site or remote applications. It is compatible with remote DDS units from o
manufacturers, but supports the greatest range of management capabilities when used in 
conjunction with any of the following GDC DSUs at the remote site: NMS 520, NMS 510, SC5
or SC 521A/S. A remote SC521A or SC 521A/S DSU is assumed to be in NMS 520 mode u
the switch on the product card is set to NMS 510 mode.

TEAM 521A Overview

The TEAM 521A Unix application is a collection of integrated applications for the HP OpenV
Network Management Platform that employs the Simple Network Management Protocol (SN
to manage GDC SC 521A or SC 521A/S DSU cards installed in a GDC SpectraComm shelf

TEAM 521A applications enable you to configure SC 521A and SC 521A/S DSUs, monitor D
operation through a Front Panel display emulating LEDs on the physical unit, and diagnose
suspected problems using local tests, remote loopbacks and self test patterns.

Special Consideration - Master/Remote Communication

• When the link is configured for DDS I or for clear channel, the management communica
occupy the same channel that carries user data. Thus, management communication ha
effect of briefly interrupting or causing errors in the user data. Error correcting protocols 
requests for re-transmission can protect user data against corruption, but the effect does 
reduce throughput.

• In configurations with communication between two shelves, both with SCMs, only a poin
point application is allowed. In such configurations, remote management is lost, along wi
End-To-End self test and the Delay diagnostic. 

• A No DTE Poll alarm trap or a No DSU Response trap from a remote will be reported
in the HPOV event log. These alarms are not reported in Alarm Detail and are non-mask

• No DTE Polling indicates the DTE connected to the remote DSU does not respond 
polling by the master unit (valid only in DDSI operation).

• No DSU Response indicates the remote DSU does not respond to polling by the master
(valid only in DDSI operation).
076R154-V400 TEAM 521A Version 4.0.0 1-1
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Theory of Operation

All of the TEAM Controller applications use the HP OpenView APIs (Application Programme
Interfaces) to integrate with HP OpenView Windows and other network management applica
Menu items are accessed via pulldown menus from the appropriate HP OpenView submap o
the Front Panel drop-down menu. The TEAM Controller GUI screens met HP OpenView pre
partner requirements. Refer to OpenView documentation for more information.

SpectraComm Manager Card

TEAM 521A applications operate in conjunction with a SpectraComm Manager (SCM) card
provide comprehensive network management capabilities using the Simple Network Manag
Protocol (SNMP). The SCM acts as the SNMP proxy agent through which TEAM managem
applications communicate with SpectraComm products and other compatible equipment.

All management communications are directed to the SCM card Internet Protocol (IP) addres
SCM card relays commands and responses between management applications and hardwa
components, using a slot addressing scheme to communicate over the SpectraComm shelf
backplane with the other components. The SCM is transparent to the applications, which ope
though they were communicating directly with the hardware units. The SCM card is manage
the TEAM Core application, which is also responsible for the discovery and mapping functio
TEAM Applications within the HP OpenView framework.

Note Refer to the SpectraComm Card Operation Manual and the TEAM Core Operation Manual and the 
associated Release Notes for detailed SCM information.

TEAM 521A Managed Remotes

TEAM 521A provides GDS/DDS full duplex operation for the remote management of its rem
units. Through the SC 521A, its remotes are fully network managed by the shelf resident 
SpectraComm Manager (SCM) and an associated SNMP manager. The following table des
briefly the function and structure of network elements remotely managed by TEAM 521A. 

Note In a multi-point configuration, only like units can be added as remotes (i.e., two NMS 520x, two NMS
etc.).

Table 1-1 TEAM 521A-Managed Remote Units

Master  Element Remote Element Operating Mode

SC 521A
or

SC 521A/S

NMS 510 GDS/DDS, full duplex, point-to-point or multi-point 
configuration, conventional and DDS with secondary channel.

The SC 521A/S also provides two interface current modes: 
Source and Sink.

NMS 520

SC 521A

SC 521A/S
1-2 TEAM 521A Version 4.0.0 076R154-V400
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The TEAM 521A Applications
All TEAM 521A applications can be accessed from either of two user interfaces. Table 1-2 lists the 
applications as they appear in the HPOV menu bar interface. Table 1-3 lists the applications as they
appear in each managed unit’s Front Panel Select  button.

Access from the HPOV Shelf Map Window Menu

1. Select the DSU you intend to work with by clicking once on its icon in the shelf map.

2. The TEAM 521A application functions are arranged on the menu bar at the top of the H
Map window as shown in  Table 1-2.

3. From the Map window, open the TEAM 521A application you intend to use.

4. To select multiple icons in a map window, click and drag a box around the desired icons
click on icons individually while holding down the Control and Shift keys. Up to ten icons
the same device type can be selected at a time. 

Table 1-2 TEAM Applications from the HPOV Menus

Menu Selection
TEAM 521A 
Applications

Description

Performance Front Panel Shows the status of the unit’s LEDs and provides an interface 
to the rest of the applications via a Select button menu.

Alarm Detail... Displays alarm information in a read-only window

DTE Status... Displays the status of signals in the DTE interface

Line Statistics... Displays information concerning the functions of the network 
interface

Configuration Configuration... Provides read/write windows for DSU configuration 
parameters. 

Maintenance... Provides read/write windows for DSU maintenance 
parameters. 

Fault Diagnosis Accesses the Diagnose application which allows you to 
command the test functions of the DSU and view test results 

Misc Information... Displays application name and revision level, similar to 
clicking on the GDC logo

Front Panel Poll Rate... Sets a default polling interval to be in effect each time the 
Front panel display is opened. 

Note Pad Opens a shell tool (editor, mail tool, etc.) for keeping records 
on the system.

Alarm Severity Changes the severioty of the alarms for a device type.

Note The Note Pad  application is selected only from the Misc menu and not available at the Front Panel m

Note Your HPOV menu may show additional selections depending on other supported applications.
076R154-V400 TEAM 521A Version 4.0.0 1-3
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Access from the SC521A Front Panel Display

The SC521A Front Panel application summarizes the real-time status of the SC521A DSU b
displaying the states of the LED indicators on the unit. A Select  button on the Front Panel 
accesses the application menus and their functions.

1. Select the DSU you intend to work with by clicking once on its icon in the shelf map.

2. At the Map window, go to the Performance menu and select the Front Panel application
Front Panel display for that unit appears.

3. In the Front Panel display, click the Select  button to access the application menu. Table 1-3 
describes the available applications. 

Table 1-3 Team Applications from the Front Panel

Applications Functions Description

Performance DSU Front Panel Shows the status of the LEDs.
Provides an interface to the rest of the applications.

Alarms Displays detailed read-only information about alarm state changes.

DTE Status Displays status information about signals at the DTE interface.

Line Status Displays information about the condition of the Line interface.

Configuration Configure Provides read/write windows for reviewing and configuring a 
selected SC 521A DSU.

Maintenance Controls device specific functions that are not part of normal 
configuration.

Fault Diagnose Runs diagnostic tests on a selected SC 521A DSU.

Misc Information Displays application name and revision level, similar to 
clicking on the GDC logo.

Note You can access the Information function by clicking the GDC logo icon on the Front Panel display. N
that the Front Panel Poll Rate, Note Pad and Alarm Severity applications are only available through
Map Window menu bar. 
1-4 TEAM 521A Version 4.0.0 076R154-V400
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Window Features in TEAM Applications

The example screens below describe the window features that are common to all TEAM 52
application windows and their subordinate windows. More information on a specific applicat
and its procedures are found later in subsequent chapters.

Table 1-4 Typical Application Window Features

Window Feature Description

Title bar Identifies the specific TEAM application running in the window, i.e., 
Configuration, Diagnostics, Alarms Reported, etc. 

Minimize button Available only when TEAM software is running on a SUN workstation in an 
OpenWindows environment.
Click to minimize window to an icon. Double-click icon to restore the window. 
Located in the Title Bar of each application window.

Menu bars Provides pulldown menus for common utilities, such as File->Exit and Help. 
Icon menus provide application-specific options.

Name field Indentifies the shelf and slot location of the card of interest, followed by the 
card’s slot: line: drop notation.

Command buttons Click command buttons to execute a command instantly, such as Reset, 
Cancel or OK. 

Pulldown lists Pulldown and scroll to select options for equipment types, function 
parameters or operation controls for the application.

Glyphs Click grayed-out diamond glyphs to select options, click again to deselect.

Entry Fields Click to activate entry field for user-defined data, such as IP addresses, 
shelf names, system information.

Multiple Select buttons Click to globally select and deselect frequently grouped options.

Data Display A panel displaying read-only information configured by the user or 
determined by the system.

Note Grayed-out buttons, fields, or lists represent options that are disabled or not available with the curre
configuration or DSU type. Refer to Chapter 3 for procedures on setting configuration parameters.

Data
Display

Multiple Select
Buttons

Selection
Gylphs

Pulldown

Command 

Minimize
Button

Lists

Buttons

Menu
Bar

Title Bar
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Chapter 2: Operations

Overview

This chapter describes the operation of the TEAM 521A applications as they are grouped un
Performance menu, Fault menu, and Misc(ellaneous) menu. Note that TEAM 521A applicat
operate the same for both SC 521A and SC 521A/S DSUs, except where noted. 

For other TEAM application menus, refer to Chapter 3, Configuration and Chapter 4, Maintenance 
and Diagnostics .

TEAM 521A Performance Menu

The Performance menu accesses the following applications:

• Front Panel application displays a representation of the DSU front panel which shows the
of the unit’s LEDs and provides access to the rest of the TEAM applications

• Alarms application displays alarm information in a read-only window

• DTE Status application displays the status of signals in the DTE interface

• Line Statistics application displays information concerning the functions of the network 
interface

Front Panel Application

The Front Panel display is a graphical interface to a selected SC 521A DSU ( Table 2-1 ). You can 
launch a SC 521A Front Panel display from the HPOV Map (shelf sub-map) window, or by do
clicking on the slot icon of the desired unit. 

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu. The application polls the DSU to 
the states of the LEDs in the Front Panel display current. The time of the most recent poll a
at the bottom of the Front Panel display, to the left of the Help button. 

The Select  button menu provides two Poll selections which determine when the applicatio
collects new information from the DSU to update the Front Panel window: Demand Poll and
Poll. When Auto Poll is enabled the last poll time appears white on the Front Panel display, 
yellow when Auto Poll is disabled. These polling options are described further in later paragr

A boxed slot icon in the shelf submap will indicate that the DSU does not have an associated 
remote. When you double-click on a boxed slot icon, the application launches the Front Pan
display of that SC 521A DSU. 

An un-boxed slot icon  in the shelf submap indicates that the DSU does have an associated 
remote. When you double-click on an un-boxed slot icon, the application opens another sub
which displays icons for the selected SC 521A and its remote. A connecting line between th
indicates that together they form a link. You can then double-click on the SC 521A icon in the
submap to launch the Front Panel display. 
076R154-V400 TEAM 521A Version 4.0.0 2-1
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Front Panel Display LEDs and Menus

The LEDs shown in the display reflect the states of the actual indicators on the physical unit.Table 
2-1 describes the appearance and function of the LEDs.

Note The TEAM Front Panel will appear the same for SC 521A and SC 521A/S units. To determine wheth
are communicating with an SC 521A/S, check the TEAM Main Configuration screen for DSU identify
information in the Card Type and Interface Current Mod e fields.  

Table 2-1 Performance Applications: The Front Panel Display

Front Panel Display LEDs Description

INS
In Service

In Service normally remains lit continuously after the DSU 
successful completion of its power-on test.
The Blink INS menu selection will cause it to blink continually.

ON Power ON

SD
Send Data

When lit, Send Data indicates that the DSU is transmitting data. A 
two-headed arrow on the LED indicate transitions.

RD
Receive Data

When lit, Receive Data indicates that the DSU is receiving data 
from the remote DSU. A two-headed arrow on the LED indicate 
transitions.

RS
Request to send

When lit, Request To Send indicates that the DTE has data to 
transmit. A two-headed arrow on the LED indicate transitions.

CO
Carrier On

When lit, Carrier On indicates that the DSU is receiving a signal. A 
two-headed arrow on the LED indicate transitions.

RSP
Response

Management Response

ICC
Inactive 

Condition Code

When lit, Inactive Condition Code indicates when the DSU network 
interface is experiencing an out of sync (OOS) or out of frame 
(OOF) condition.

NS
No Signal

No Signal is lit when the DSU is not receiving a signal at its 
network interface.

TM
TEst Mode

Test Mode is lit red while the DSU performs a diagnostic test. 
During a test employing Self Test, a two-headed arrow on the LED 
indicates that errors have been detected.

ALM
Alarm

Alarm, indicates by its color that the DSU has detected an alarm 
condition. The colors match those of map icons for the unit.

ST
Self Test

Self Test is lit while the internal test pattern generator/checker is 
active.

LT
Local Test

Local Test is lit while the DSU is in the Local Loopback test 
condition.

RL
Remote Loop

Remote Loop is lit while the DSU is performing a remote loopback 
test with the remote DSU.

DL
Digital Loop

Digital Loop is lit while the DSU is performing a digital loopback to 
direct data back to the remote DSU.

GDC Icon Clicking the GDC icon displays the application name and the 
revision level.

Select Button Opens menu list for selecting other TEAM applications.
Refer to Table 2-2.
2-2 TEAM 521A Version 4.0.0 076R154-V400
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The Front Panel Select Menus

The Select  button, at the bottom of the Front Panel display provides access to menus for th
of the TEAM 521A application functions. The following table shows the arrangement of the 
Select  button menus. Note that it differs slightly from the Map window menu bar arrangem

Table 2-2 Front Panel Select Button Menus

Menu Selection Description

Performance Alarm Detail... Displays alarm information in a read-only window

DTE Status... Displays the status of signals in the DTE interface

Line Statistics... Displays information concerning the functions of the network 
interface

Configuration Configuration... Provides read/write windows for DSU configuration 
parameters.

Maintenance... Provides read/write windows for DSU maintenance 
parameters. 

Fault Diagnosis Accesses the Diagnose application which allows you to 
command the test functions of the DSU and view test results.

Demand Poll Causes an immediate 
update of the display. Determines when the application collects new information 

from the DSU to update the Front Panel window.Auto Poll 15, 30, or 60 seconds
Disable

LED Test On or Off Demonstrates functioning of the Front panel LEDs. 

Exit Dismisses the Front Panel 

Note If you disable Auto Poll, the Front Panel window displays a static snapshot of the LED states as the
were at the last poll, either when the window was launched or a subsequent Demand Poll. 
076R154-V400 TEAM 521A Version 4.0.0 2-3
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Alarm Application

The Alarm application gets Network, DTE and Unit alarm indications from the selected DSU
polling the SCM for changes in alarm conditions or by receiving traps that the SCM sends in
response to alarm conditions at the DSU. The initial polling rate is determined by the poll ra
selected at the HPOV map window Misc menu. The TEAM 521A Alarm Detail window provi
a File menu and displays the read-only alarm status of the DSU (Table 2-3).

Table 2-3 Performance Applications: The Alarm Detail Window

Alarm Detail Window
Alarm 
Type

LEDs Description

Network 
Alarms

Bipolar Variation Failure of consecutive ones to alternate 
states in the signal being received.

Jitter Excessive jitter (phase shift) in the signal 
being received.

Frame Loss Out of frame condition at the network 
interface.

Receive Signal 
Low

Low signal level being received at the 
network interface.

DTE 
Alarms

Data Carrier 
Detect Loss

Loss of incoming signal or a line idle 
condition.

Data Set Ready 
Loss

DSU is not asserting Data Set Ready to 
the DTE.

Data Terminal 
Ready Loss

DSU is not receiving Data Terminal Ready 
from the DTE.

Receive Data Loss Reception of valid carrier without data 
(switched receive carrier operation only).

Transmit Data Loss No data within transmit polls 
(switched transmit carrier operation only).

Streaming Constant RTS condition.

Unit 
Alarms

No Signal Indicates loss of signal at the network 
interface.

Line Pairs 
Reversed

Indicates the DDS line was incorrectly 
installed at the network interface.

STC Loopback DSU has been commanded into a test by 
the Telco Serving Test Center (STC) 

Front Panel Test DSU has been commanded into a test by 
means of its front panel switches.

No Loop Current Absence of DC current at the Line 
interface

EEPROM 
Checksum

Non-volatile memory that stores the DSU 
configuration has become corrupted

Transmitter Failure Failure of the DSU to transmit data.

Top Power 
Supply Fail

Top power supply failure in the 
SpectraComm 2000 enclosure (see note).

Bottom Power 
Supply Fail

Bottom power supply failure in the 
SpectraComm 2000 enclosure (see note).
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Alarm Detail File Menu

The Alarm Detail File menu contains the following functions:

• Demand Poll  causes an immediate update of the display. 

• Auto Poll  enables you to select updates at 15, 30, or 60 second intervals, or to disab
automatic polling. 
If you select Disable , the Front Panel window displays a static snapshot of the LED state
they were at the last poll, either when the window was launched or a subsequent Deman
The last poll time appears white on the front panel display when Auto Poll is enabled an
appears yellow when Auto Poll is disabled. 

• Exit  dismisses the window.

Note You can change the default alarm severity by means of the Alarm Severity Feature within the TEAM 
application.

Note Alarms for Top and Bottom Power Supply Fail are valid only for SC521A installed in the SpectraComm
enclosure.
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DTE Status Application

The DTE Status application displays the read-only status of the EIA signals at the DTE inter
The initial polling rate is determined by the poll rate selected at the HPOV map window Misc m
The TEAM 521A DTE Status window provides a File menu and displays the LEDs as dark g
light green, or light green with transition arrows. Table 2-4 describes the appearance and the 
function of the LEDs in the DTE Status Window.

DTE Status File Menu

The DTE Status File menu contains the following functions:

• Demand Poll  causes an immediate update of the display. 

• Auto Poll  enables you to select updates at 15, 30, or 60 second intervals, or to disab
automatic polling. If you select Disable, the Front Panel window displays a static snapsh
the LED states as they were at the last poll, either when the window was launched or a 
subsequent Demand Poll. The last poll time appears white on the front panel display whe
Poll is enabled and appears yellow when Auto Poll is disabled. 

• Exit  dismisses the window. 

Table 2-4 Performance Applications: The DTE Status Window

DTE Status Window LEDs Description

CTS Clear To Send
Bright Green indicates signal is ON.

RTS Request To Send
Bright Green indicates signal is ON.

DTR Data Terminal Ready
Bright Green indicates signal is ON.

DSR Data Set Ready
Bright Green indicates signal is ON.

DCD Data Carrier Detect
Bright Green indicates signal is ON.

DSP Data Set Power
Bright Green indicates signal is ON.

TXC Transmit Clock
Arrow in LED indicates transitions.

RXD Receive Data
Arrow in LED indicates transitions.

TXD Transmit Data
Arrow in LED indicates transitions.
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Line Statistics Application

The Line Statistics application displays DSU occurances at the network interface during the
recent 15 minutes. The TEAM 521A Line Statistics window is described below.. 

Line Statistics File Menu

The Line Statistics File menu contains the following functions:

• Demand Poll  causes an immediate update of the display.

• Save Data To File....  allows you to save to file the most recent 15 minutes of data
a format similar to the appearance of the Line Statistics display screen. The file type suf
“521ALineStats” is automatically appended if not already present. 

• Auto Poll  sets the intervals at which the application polls the unit. Values are 1, 2, an
minutes and Disable. 

• Exit  dismisses the Line Statistics window

Table 2-5 Performance Applications: Line Statistics Window

Field Selection Description

Statistics
(Last 15 
minutes)

Minute Interval Identifies the time frame for the other six columns. Each row represents 
one minute. 

Status Displays Normal or No Signal.

Transmit Level Display the strength (in dB) of the signals being sent by the DSU. 

Receive Level Display the strength (in dB) of the signals being received by the DSU. 

Phase Jitter Displays the percentage by which phase shift in the received signal 
exceeds acceptable levels. 

BPV Count Displays the number of BiPolar Violations, where consecutive ones in 
the signal being received did not alternate states.

Frame Loss Displays the number of times framing bits could not be identified.
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TEAM Diagnose Application
From the HPOV Map Fault Menu or from the Front Panel Fault menu, you can access the T
521A Diagnose application. When you launch the application, it displays one read/write win
where you can control a variety of test functions on the DSU. 

• The Diagnose File menu provides Exit , which dismisses the Configure window. 

• The Navigate File menu accesses the History  screen which displays the test results 
accumulated during the most recent diagnostic session.

Note Refer to  Chapter 4: Maintenance and Diagnostics for detailed information on these TEAM applications.

TEAM Miscellaneous Applications
The following applications are available from the shelf map Misc menu.

Front Panel Poll Rate Application

Launch the Front Panel Poll Rate window from the HPOV 
shelf map Misc menu. The setting you select in this window 
determines the initial polling rate for Front Panel displays each 
time they are opened. 

The rate selection is a global function. It selects initial polling 
rate for all front panel displays linked to a TEAM Core 
application, regardless of which individual application you 
access it from. The precise polling frequency that results from 
a setting of Slow, Normal, or Fast depends on a number of 
factors. The higher the rate, the more communication and 
processor capacity is devoted to maintaining the display. 

Setting a Global Poll Rate 

1. Set the a global polling rate for all front panels by clicking 
an appropriate diamond:

• Slow 

• Normal 

• Fast 

• Demand Poll Only

2. At the Front Panel Poll Rate File menu, select Save to File  to store the setting for all 
front panel displays. 

3. From the File menu select Exit  to dismiss the window. 

Setting an Individual Poll Rate

To change the polling rate for an individual front panel, at the unit’s Front Panel display, use
Select  button to set the Auto Poll. The change is only valid for the duration of a session an
not saved when the front panel display for that DSU is closed.
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Note Pad Application

Launch the Note Pad application from the shelf submap Misc menu. The application opens 
editor which can be used for keeping records on the system. 

TEAM Information Application

Launch the TEAM 521A Information window from the HPOV shelf map Misc menu or by dou
clicking on the GDC logo in the Front Panel display. This application displays one read-only
window that contains the name of the application, software revision level information, and 
copyright information. The File menu in the menu bar contains only the selection Exit , by which 
you can dismiss the window. 

Alarm Severity Application

Launch the TEAM Core Alarm Severity window from the HPOV Map Misc menu. This applica
displays one read/write window for selecting equipment type and also displays the alarm seve
(major, minor, or warning) for each alarm of that equipment type. For more information on Ala
Severity and other TEAM Core-specific applications, consult the TEAM Core Operation Manua
Release Notes.

Alarm Severity File Menu

The Alarm Severity File menu provides the following selections:

• Refresh  re-reads and re-displays the Alarm Severity window.

• Save to File  stores the edits to a file.

• Reset All to Defaults  resets the alarm severity of all equipment types to their defa
settings.

• Reset “equipment type” to Defaults  resets the alarm severity of the selected 
equipment type to its default setting.

Exit  dismisses the Alarm Severity window.
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Chapter 3: Configuration

Preparing for DSU Configuration
This chapter describes the TEAM521A Configuration and Maintenance applications which a
you to set all the options in the SC 521A through a convenient group of configuration windo
These TEAM configuration applications operate the same for both the SC 521A and SC 521
DSUs, except where noted. Before you begin an initial configuration in a new system, ready
system as follows:

1. Assign an IP address to the SpectraComm Manager (SCM).
Consult the SpectraComm Manager Card Installation and Operation Manual.

2. Ensure the SCM is correctly configured. 
Consult the SpectraComm Manager Card Installation and Operation and TEAM Core 
Operation manuals.

3. Consult HP OpenView documentation and make sure that HP OpenView is configured f
SNMP management. 

TEAM Configuration Applications
TEAM 521A Configure application is launched from the HPOV Map Configuration Menu or fr
the Front Panel menu. The application initially displays the read-only TEAM 521A Configura
window, which includes a File menu and Navigate menu. Button glyphs appear on the 
Configuration windows for quick access to the pulldown menu items. Throughout the text 
descriptions in this chapter, keypresses and default values will be shown in Bold. Accompanying 
screens are representative and may appear differently on your system.

Starting the Configuration Application
You can start the TEAM 521A Configuration application by either of two methods: 

• Select a DSU symbol on the shelf submap in OpenView, then select the Configure option
the Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration and se
Configure from the resulting menu. 
076R154-V400 TEAM 521A Version 4.0.0 3-1
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The Main Configuration Window
When you launch the configuration application, the current configuration is read from the DSU
main window appears, as shown below, for either the SC 521A or SC 521A/S DSU. For both
of DSUs, the window displays the same read-only status of the operation and software comp
of the DSU.

For an SC 521A/S DSU, the TEAM Configuration window will display additional hardware 
information field concerning the unit’s Sealing Current function. Table 3-1 describes these read-
only fields.  The application also provides a File menu a Navigate menu, and a button bar for
access to menu items.

Table 3-1 Main Configuration Window Display 

System 
Component

Field Description

Identification Name Displays shelf and slot identification for the DSU.

Operation Slot Status Displays the state of the shelf slot as Active or Inactive.

Operational Status Displays the state of the current unit as Up or Down.

Software Serial Number Displays the serial number of the DSU.

Active Firmware Rev Displays the current level of the DSU operating code.

Standby Firmware Rev Displays the backup revision level of the DSU code.

Boot Code Rev Displays the Non Volatile memory revision level of the DSU 
Boot code for downloading firmware.

MIB Version Displays the revision level of the MIB files that enable SNMP 
control.

Hardware DTE Interface Type Displays the interface type for the DTE.

Card Type Displays the Card Type as SC 521A or SC 521A/S.
SC 521A/S must be firmware version (05.00.00 or higher).

Interface Current Mode For SC 521A/S units, displays the sealing current mode as 
Source or Sink. For SC 521A units, the field is grayed-out.
3-2 TEAM 521A Version 4.0.0 076R154-V400
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The Main Configuration Window Menus

The Configuration menu provides a File menu for storing and retrieving configuration settings
a Navigate menu for accessing separate option windows used to configure the DSU. Table 3-2 
describes the menu selections. Basic configuration procedures follow the table. Specific 
configuration windows and their options are described in later paragraphs. 

Using Configuration Templates

Configuration changes can be made using the current configuration as a starting point, or b
retrieving a previously stored configuration template. Either way, the DSU continues to oper
using its unchanged current configuration. A template contains a set of configuration options f
operating the DSU in a particular way. You can store as many templates as you need. The 
template can be loaded on the workstation that runs the TEAM 521A application. To load 
configuration settings from a template into the DSU, perform the following steps: 

1. Select Load Template  from the File menu.

2. Select the template from the resulting dialog window. The application retrieves the 
configuration settings of the selected template. 

3. Select Save to Unit  from the File menu. The application makes the template 
configuration settings the current operating configuration for the DSU.  

4. Continue the configuration change process according to the procedure below.

Table 3-2 Configuration Window Menus and Options

Menu Selection Description

File Refresh Causes the application to read and apply the current 
configuration from the DSU. Any changes not saved 
to template are lost when you select Refresh.

Save to Unit Saves a new configuration to the DSU.

Load Template Causes the application to display a list of selectable 
templates containing previously stored configuration 
settings.

Save to Template Saves a new configuration as a template in the 
workstation.

Compare to Template

Exit Dismisses the Configuration window.

Navigate System Options... Launches the System Options window.

Network Options. Launches the Network Options window.

DTE Options... Launches the DTE Options window.

Diagnostic Options... Launches the Diagnostic Options window.

Alarms Reported... Launches the Alarms Reported window.

All Above Screens... Launches all of the configuration option windows.

Add Remotes... Launches the Add Remotes window.

No Screens Closes all of the configuration windows.
076R154-V400 TEAM 521A Version 4.0.0 3-3
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Configuration Change Procedure

To edit the current configuration of the DSU, from the Navigate window select a configuratio
window in which you intend to make changes. Continue with the procedure below. To edit a
template, select Load Template  from the File menu. Select a template from the list of previou
saved templates. A configuration window opens in which you can make changes. Continue w
procedure below.

1. In the selected Configuration window, click on the input field for an option. A window ope
to display all the available values for that field. 

2. Click and hold down the mouse button on the values list until the highlight is on the value
intend to configure, then release the button. The newly selected value appears in the ent
for the configuration item. 

3. You can discard changes to a configuration window and return all its fields to their previo
values in two ways:

• Click on the Reset  button to discard changes while keeping the window open.

• Click on the Cancel  button to discard changes and dismiss the window. 

4. You can close a configuration window without losing changes by clicking on either the OK 
button, or the pushpin icon  located in the upper left corner of the window.

5. You can keep multiple configuration windows open on-screen and move between them 
clicking the mouse on the one in which you intend to operate. The main Configuration win
remains on-screen throughout the configuration process. 

6. When you have accessed and made changes on all the desired configuration windows, 
Save to Unit  from the File menu of the main Configuration window. This saves the n
configuration in the DSU, with the changed configuration as the current configuration for
unit.

7. Select Save to Template  to save it as a template in the workstation. A window appea
containing a list of existing templates and a field for entering a new template name. 

8. Select an existing template to be overwritten with the new configuration, or enter a name
create a new template. This newly stored template is now available for loading by the 
application to any SC 521A DSU. It can also be retrieved and saved with further modifica
if desired. 

Note When you change the value or setting of an option, the application displays the option name and the
value in white, rather than black, type. They remain white until you either save the changes to the DS
a template by means of the Main window File menu, or restore the option to its last stored value or se
3-4 TEAM 521A Version 4.0.0 076R154-V400
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Configuration Option Windows
From the navigation menu, the following buttons appear which allow you to launch and chan
settings of specific configuration windows:

• System Options

• Network options

• DTE Options

• Diagnostics Options

• Alarms Reported

• All Above Screens

• Add Remote

The following paragraphs describe in detail the characteristics of each configuration option 
window. Refer to the Configuration Change procedure (above) for instructions on selecting,
resetting, or cancelling changes made in any of the configuration option windows.

System Options

The System Options window opens when you click the associated button in the Navigation menu. 
The Name field display read-only shelf and slot identification for the DSU. Table 3-3 describes the 
configuration options available from the System Options window.

Note Additional buttons from the Navigate menu allow you to set screen viewing preferences and provid
alternative means of accessing File menu items.

Table 3-3 System Options Window

System Option Window Option Description

Alarm Scan Configures the alarm scan:

Enable - DSU reports alarms to the SCM
Disable - DSU does not report alarms to
   the SCM.

Front Panel Allows you to disable front panel switches to 
avoid accidental interruption of DSU operation:

Enable - DSU front panel switches are 
operational.
Disable - DSU front panel switches are 
disabled.

Rsp Timeout Selects the length of time the SCM waits for a 
response from the DSU before it declares a No 
Response condition:

2, 4, 6, or 8 seconds
076R154-V400 TEAM 521A Version 4.0.0 3-5
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Network Options

The Network Options button launches window 
shown below. The Name field displays read-
only shelf and slot identification for the DSU. 
The Network and Circuit Parameters are 
described below.

Network Parameters
Circuit Type selects the type of circuit over 
which the DSU communicates with its remote 
unit(s):

• Point to Point

• MultiPoint

Line Type defines the line type which may be 
applied to the circuit:

• Clear Channel specifies a point-to-
point 64 kbps circuit.
When this is selected the Data Rate 
option is forced to this value and 
cannot be changed.

• DDS-I specifies a DDS-I circuit at 
any data rate, up to 56 kbps 

• DDS-SC specifies a DDS-SC circuit 
at any data rate up to 56 kbps.

Carrier  selects the combination of transmit and receive carrier modes (constant/switched) w
will be applied to the DSU:

• Tx Constant, Rx Constant – used on a point-to-point circuit

• Tx Constant, Rx Switched – used when the DSU is the master unit on a multi-point c

• Tx Switched, Rx Constant – used when the DSU is a remote unit on a multi-point ci

• Tx Switched, Rx Switched – used when required by specialized applications .

Data Rate selects the data rate and mode (synchronous/asynchronous) to be applied to the

• 2.4 Kbps - Async 

• 2.4 Kbps - Sync 

• 4.8 Kbps - Async 

• 4.8 Kbps - Sync 

• 9.6 Kbps - Async 

• 9.6 Kbps - Sync 

• 19.2 Kbps - Async

Note This option affects the Reported/Not reported states of the RxD Loss and TxD Loss alarms in the A
Reported configuration screen. When a constant carrier is selected, the corresponding data loss ala
that screen is forced to Not Reported (unchecked) and appears grayed out. If the alarm had previou
been selected to as Reported, the change will not go into effect until the configuration is saved to the
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• 19.2 Kbps - Sync 

• 56 Kbps - Sync

• 64 Kbps - Sync 

 Circuit Parameters

Tx Clock Source selects the source of transmit timing for the DSU as follows: 

• Receive – transmit timing is based on receive data timing

• Internal – transmit timing is provided by the DSU internal clock
(for wireline only). 

• External – transmit timing is provided by the DTE.
With this option selected, the Buffer Clock is forced to External and cannot be cha

Buffer Clock selects the source of timing for the buffer between the DSU and its DTE. The 
following buffer clock options may be applied to the DSU: 

• Internal  – buffer timing is provided by the selected Tx Clock Source (Default). 

• External – buffer timing is provided by the DTE.
When the Tx Clock Source is set to External, the Buffer Clock cannot be changed.

Zero Encoding selects Zero Encoding, which is sometimes required for 56 kbps DDS-SC (PT
applications in which the primary and secondary channels are not permitted to transmit all s
(zeros) at the same time. The DSU may be configured to:

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth.

• Disable – DSU does not prevent the all space condition.  

Remote Unit Type specifies the type of remote DSU used with the DSU. This option is only 
available for configuration when the Circuit Type option in the Network Options configuration 
window is selected as Multipoint, and no remote units have yet been added by the Add Remo
application. In all other circumstances, the Remote Unit Type is overridden and is grayed ou
Under the proper conditions, you can select:

• NMS 520 or SC521A In 520 Mode
When the remote DSUs are specified to be NMS 520 units, SC 521A units in 520 m
or SC 521A/S units in 520 mode, the options Sentry Timer, Rmt Rsp Interval, and A
Hysteresis are available for configuring.

• NMS 510 or SC521A In 510 Mode 
When the remote DSUs are specified to be NMS 510 units, SC521A units in 510 m
or SC 521A/S units in 510 mode, the options Sentry Timer, Rmt Rsp Interval, and Alarm 
Hysteresis are not available for configuring.

Note The 64 Kbps value is displayed when the Data Rate option is forced by selection of Pt to Pt - Clear C
nel in the Circuit Type option.

Note Check with your service provider to determine whether Zero Encoding should be enabled.
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Sentry Timer selects the time interval between alarm reports from a remote SC521A (config
as a NMS 520) or NMS 520 DSU for a DDS1 or clear channel point-to-point link. You can s

• Disable 

• 1 Minute to 5 Minutes – in one minute increments

• 10 Minutes 

• 15 Minutes to 60 Minutes – in 15 minute increments

• 60 minutes

• 90 Minutes

• 120 Minutes 

Rmt Rsp Interval selects the minimum time interval permitted between alarm reports from a
remote SC521A (configured as a NMS 520) or NMS 520 DSU in a DDS1 multi-point link.

• Disable 

• 10 Seconds

• 10 Seconds to 120 Seconds – in ten second increments

Alarm Hysteresis selects the minimum time between alarm change reporting from a remote 
SC521A (configured as a NMS 520) or NMS 520. You can select:

• 10 Seconds to 120 Seconds – in ten second increments 

Circuit Assurance
When this option is enabled, the DSU disables Clear To Send when it detects any of the following
conditions: Idle, Out of Service, Out of Frame, No Signal, Abnormal Station Code, or other ina
channel code. You can select:

• Disable

• Enable 

System Status
When this option is enabled, the DSU disables Data Set Ready when any of the following conditions
are detected: Idle, Out of Service, Out of Frame, No Signal, Abnormal Station Code, or othe
inactive channel code. You can select:

• Disable

• Enable 

Note All remote units on a multi-point link must be set for the same Remote Response Interval value.
3-8 TEAM 521A Version 4.0.0 076R154-V400
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DTE Options

The DTE Options window opens when you click the 
associated button in the Navigation menu. The Name 
field displays read-only shelf and slot identification for 
the DSU. Options for Interface, Control Parameters, 
and Async Parameters are described below. 

Interface Displays and Parameters

Interface Type is a read-only field which displays the 
DTE port type as one of the following:

• RS232 – EIA/TIA-232-E interface 

• V.35 – ITU-T V.35 interface 

Interface Adapter is a read-only field which reports 
whether or not the DSU has a Data Rate Adapter (DRA) 
or EIA 530 card installed. The field displays: 

• None 

• Installed 

Control Parameters

AAS selects whether or not the DSU provides 
Automatic Anti-Streaming protection, and the time 
limit it enforces when the feature is enabled. You can 
select:

• Disable

• 5 Seconds

• 10 Seconds

• 30 Seconds

• 45 Seconds

Constant DSR selects the DSU to output either a constant or a controlled Data Set Ready sig
its DTE. You can select:

• Disable – controlled DSR signal controlled by DTR 

• Enable – constant DSR signal

CTS Delay selects the delay (if any) between the DSU receiving Request To Send from the DTE 
and returning Clear To Send to the DTE. You can select:

• CTS ON – no delay; grayed out when multi-point link is selected Circuit Type 

• Fixed 3 Char – equivalent to three line signal character times

• 0 msec 

• 30 msec 

• 60 msec 

• 90 msec 

HDLC Invert selects whether or not the DSU uses inverted channel data from the DTE. 
Data inversion is used primarily with DDS-SC 56 kbps circuits in order to enhance data qua
a network that does not provide clear channel capability. You can select:
076R154-V400 TEAM 521A Version 4.0.0 3-9
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• Disable – normal data

• Enable – inverted data 

Async Parameters

The Async Parameters options are grayed out when the Sync/Async option is selected for 
synchronous. Otherwise, the parameters described below are available for configuration.

Character Size selects the number of bits per asynchronous character, including start and sto
You can select:

• 11 Bits

• 10 Bits 

• 9 Bits 

• 8 Bits 

Over Speed selects the percentage above its configured normal operating rate at which the 
can accommodate asynchronous receive data. You can select:

• 1% 

• 2.3%

Suppression determines what actions the DSU takes concerning the transmit and receive En
Text (EOT) character. You can select:

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals

• Rx EOT – the DSU deletes EOT from the end of received signals.
It does not insert EOT at the end of transmissions.

• Tx EOT – the DSU inserts EOT at the end of transmissions.
It does not delete it from the end of received signals.

• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals.

Rate Adaption specifies the DTE interface operating rate when it is below that of the DDS cir
This parameter is valid only when Data Rate in the Network Options screen is set to 2.4 Kbps 
Async, and the Data Type Option is Async. Under the proper conditions you can select:

• Disable

• 600 

• 1200 

• 1800 to 2400

Note: IMPORTANT: Consider the following factors before changing the HDLC Invert option: 

Set only this option and save the change to the unit. Do not combine it with any other config
tion changes. The HDLC option must be set the same at both ends of the link. 

Make changes at the remote DSU first, before changing the option setting at the DSE. Chan
the option at the remote results in an “SNMP ‘Set’ Request Failed” error message and cau
loss of communication between the remote and master units. Click on OK in the error mess
box to dismiss the message, then proceed to change the option setting at the master. Com
cation resumes when the option change goes into effect at the master unit.
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Diagnostic Options

The Diagnostic Options window opens 
when you click the associated button in the 
Navigation menu. The Name field displays 
read-only shelf and slot identification for 
the DSU. Two groups of option, DTE 
Equipment and Network Parameters, are 
described below. 

DTE Equipment

Line Loopback Control determines 
whether or not the DTE can command the 
DSU into a Line Loopback (local) test by 
means of a signal at the interface port on 
EIA pin 18. You can select:

• Enable 

• Disable 

Remote Loopback Control determines 
whether or not the DTE can command the 
DSU into a Remote Loopback test by means 
of a signal at the interface port on EIA pin 
21. You can select:

• Enable 

• Disable

Data Set Ready determines how the DSU controls the DSR output to the DTE during test mo
You can select:

• Off During Test 

• Normal – DSR operates in the same way that it is optioned to function during data m
operations

Network Parameters

Line Loopback Test Points determines whether a Line Loopback command causes the DSU 
to loop transmitted data back to the DTE, or also to loop received data back to the network. Y
select: 

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only

• Network & DTE – Line Loopback command causes DSU to loop data in both direc

Telco Latching Loopback Response determines whether or not the DSU accepts the latching-t
DSU Loopback command code from a Telco Serving Test Center (STC). The latching-type 
command code places the unit into the test condition, which continues until a second comman
is sent by the STC. The DSU always accepts the non-latching DSU loopback command code
places the unit in the test condition only as long as the code continues to be received. 
You can select:

• Enable – DSU accepts latching-type DSU Loopback command code

• Disable – DSU does not accept latching-type DSU Loopback command code
076R154-V400 TEAM 521A Version 4.0.0 3-11
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Customer RDL Response determines whether or not the DSU accepts a remote loopback 
command from its remote DSU. You can select:

• Enable – DSU accepts the remote loopback command selected by the RDL Initiati
Sequence option.

• Disable – DSU does not accept a remote loopback command.

RDL Auto Timeout  determines whether or not the DSU ends remote digital loop automatica
based on a timeout. you can select:

• 10 Minutes – DSU terminates remote digital loop after ten minutes without need fo
further operator action. You can end the test manually before the timeout. 

• Disable – remote digital loop continues until terminated by operator action

RDL Initiation Sequence 
This option selects the remote loopback command which the DSU will send when initiating,
accept from its remote DSU when receiving. Depending on the card type, Interface current 
and circuit type, the selections for the RDL Initiation Sequence will vary as described in Table 3-4. 

Table 3-4 RDL Initiation Sequence Selections

Card Type Circuit Type
INTFC Current 

Mode
RDL Initialization Selections

SC 521A Point-to-Point
Multi-Point

Not Applicable GDC (NMS510/520) 
PN 127 

V.54 (DEFAULT)SC 521A/S Multi-Point
Point-to-Point

Sink Mode

SC 521A/S Multi-Point Source Mode GDC (NMS510/520) 
PN 127 

V.54 (DEFAULT)
CSU RL

SC 521A/S Point-To-Point Source Mode

Note Before running a Data Loop test on a remote, make sure the Customer RDL Response is Disabled 
Diagnostic Option window.

Note When the GDC option is selected for the RDL Initialization Sequence, the DSU will only command 
NMS510 or NMS520 remotes into a remote loopback test.
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Alarms Reported

The Alarms Reported window opens when 
you click the associated button in the 
Navigation menu. The Name field displays 
read-only shelf and slot identification for the 
DSU. Three groups of configurable alarm 
condition reporting, Network, DTE, and Unit, 
are described below.

Buttons and Option Selection

Each alarm option in the Alarms Reported 
configuration window has an associated 
diamond-shaped selection field. 

• Select or de-select individual alarm 
options by simply clicking the mouse 
button on the appropriate selection fields. 
Selected fields will display a highlight. 
When an alarm option is selected, that 
alarm will be reported to the DSU. The 
selection fields without highlights 
indicate alarm options which will not be 
reported to the DSU. 

• Click the Report All  button to select 
and highlight all of the alarm option 
selection fields. Similarly, you can click 
the Report None  button to de-select 
and remove the highlights from all of the 
selection fields. After clicking Report 
All  or Report None  you can change 
the state of individual fields as needed. 

Network Alarm Options

Each Network alarm, when designated to be reported, requires you to specify a threshold a
which it is evaluated. Default for all is Masked; listed default threshold value takes effect whe
alarm is set to Reported. 

Alarm Interval  determines the time span for threshold evaluation. Select:

• 1 min, 5 min, 10 min, 15 min 

Bipolar Violation  determines whether or not Bipolar Violation (BPV) alarms are to be reporte
network BPV occurs when the signal the unit receives at its network interface does not alter
between signal levels as required for Bipolar Return to Zero (BRZ) coding. The alarm occurs
the number of Bipolar Violations in the received signal during one Alarm Interval exceeds th
selected threshold. Select:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Jitter  determines whether or not Jitter alarms are to be reported. The alarm occurs when the 
of jitter in the received signal remains above the selected threshold for at least one Alarm In
Select:

• 1%, 2%, 5%, 10%, 20%, 40%, 60%, 80%, 99% 
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Frame Loss determines whether or not Frame Loss alarms are to be reported. The alarm oc
when the number of lost frames in the received signal during one Alarm Interval exceeds th
selected threshold. This alarm is for DDS/SC services only. Select:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Receive Signal Low determines whether or not Rx Signal Low alarms are to be reported. The a
occurs when the strength of the received signal remains below the selected threshold for at le
Alarm Interval. Select:

• -50 dB, -40 dB, -30 dB, -20 dB, -10 dB, -5 dB, 0 dB, 6 dB

DTE Alarm Options

The Default for all DTE alarm options is Masked. 

• Data Carrier Detect Loss – indicates loss of Data Carrier Detect.

• Data Set Ready Loss – indicates loss of Data Set Ready.

• Data Terminal Ready Loss – indicates loss of Data Terminal Ready signal from DT

• Receive Data Loss – indicates no receive data from the remote DSU.

• Transmit Data Loss – indicates no transmit data from the DTE.

• Streaming – indicates constant RTS condition. 

Unit Alarm Options

The Default for all DTE alarm options is Masked. 

• No Signal – indicates loss of signal at network interface.

• Line Pairs Reversed – indicates line pairs reversed at network interface. 

• STC Loopback – indicates the DSU has been commanded into a test mode by the
Serving Test Center (STC) or by a Remote Digital Loop command from its remote D

• Front Panel Test – indicates the DSU has been commanded into a test mode by m
its front panel switches. 

• No Loop Current – indicates no current at network interface. 

• EEPROM Checksum – indicates detection of an error in the non-volatile memory.

• Transmitter Failure – indicates that the DSU has failed to transmit data.

• Top Power Supply Fail - indicates a top power supply failure in the SpectraComm 2
enclosure (see note below).

• Bottom Power Supply Fail - indicates a bottom power supply failure in the SpectraCo
2000 enclosure (see note below).

Note The Receive Data Loss and Transmit Data Loss alarms are dependent on the configuration of the C
option in the Network Options screen. That option selects combinations of switched and constant re
and transmit carriers. When a constant carrier is selected, the corresponding data loss alarm in this
screen is forced to Not Reported (unchecked) and grayed out. If the alarm had previously been selec
be Reported, the change does not go into effect until the configuration is saved to the unit.

Note Alarms for Top and Bottom Power Supply Fail are valid only for SC521A installed in the SpectraCo
2000 enclosure.
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Add Remote

The Add Remote window opens when you click the associated button in the Navigation menu. This 
configuration window allows you to add an available SC521A, NMS 520 or NMS510 remote
to a master SC521A. The appearance of the window depends on whether you selected a P
Point or Multi-Point circuit type, as shown in Figure 3-1.

Both types of Add Remote windows display read-only shelf and slot identification for the DS
Specific selections in each window are described below. 

Figure 3-1 Add Remote Window (Point-to-Point and Multi-Point Circuit)

Add Point-to-Point Circuit Remote

The Add Point to Point Circuit Remote window contains a read-only Serial Number field and
Wake Up Remote Button. Perform the following procedure to add the remote DSU in a poin
point circuit: 

1. Select Add Remote  from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Click on the Wake Up Remote  button. This commands the TEAM 521A application to 
create the software structures required to command and monitor the remote DSU in 
conjunction with the master DSU. 

3. The application indicates a successful Wake Up by displaying the serial number of the 
associated remote DSU. 

4. Click OK to dismiss the window. 
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Add Multi-Point Circuit Remote

The Add Multi Point Circuit Remote panel contains a read-write Serial Number field, a Drop e
field, an Add Remote button and a Current Remotes display. The Serial Number field allows
to specify the serial number of the unit you are adding. A message appears above the Serial N
field as a reminder of the types of remotes allowed, based on the remote unit type specified
Network Options (SC521A or NMS 520 units, SC521A or NMS 510 units).  

1. Select Add Remote  from Main Configuration window Navigate menu. The Add Remote 
window appears. The Serial Number field is blank when the window first appears. 

2. Enter the 16-digit serial number of the remote you are adding. 

3. Click on the Drop  entry field and from the resulting menu select the drop number you are
assigning to unit. 

4. Click on the Add Remote  button. This commands the TEAM 521A application to create t
software structures required to command and monitor the remote DSU in conjunction wi
master DSU. 

5. The application indicates a successfully added remote by making an entry for the new d
number on the Current Remotes list. 

6. Click OK to dismiss the window. 

 

Note The Remote Unit Type option in the Network Options window determines which remote type can be a
If you change the setting of that option, you cannot add a remote until the change is saved to the u

Note The remote management feature cannot be used when two master SC521As are used in a link. Th
Remote function can only be used when there is one Master 521A in a link. 

Note If you change the circuit type, the change will take effect in the appearance of the Add Remote screen
you click the Add Remote button from the Navigate menu.
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Chapter 4: Maintenance
and Diagnostics

TEAM 521A Maintenance Application
The TEAM 521A Maintenance application provides a group of functions for controlling some
aspects of DSU operation that fall outside the scope of the Configure application. You can l
the TEAM 521A Maintenance application from the HPOV Map Configuration Menu or from t
Front Panel menu. The TEAM 521A Maintenance window  (Table 4-1) displays the read-only shelf
and slot identification for the DSU and Maintenance options as described below. 

Table 4-1 TEAM 521A Maintenance Options

The Maintenance Window Option Buttons Description

Front Panel Enables or Inhibits the hardware switches on the 
front panel of the SC 521A or SC 521A/S DSU. 
The text on the button toggles between the two 
options each time you click on the button.

Inhibit Front Panel -  switches are enabled
Enable Front Panel - switches are disabled. 

Reset to Factory Resets all DSU options to the factory default 
settings. When clicked, a warning appears as 
follows:
“Resetting to factory defaults will disrupt 
communications to the unit. Do you want to 
continue?” 
Click the OK button to complete the reset, or 
click the Cancel button to cancel the reset. 

Perform Soft Reset The DSU performs a reset and resumes 
operation using its current configuration. when 
clicked, a warning appears as follows:
“Performing a soft reset will disrupt 
communications to the unit. Do you want to 
continue?” 
Click the OK button to complete the reset, or 
click the Cancel button to cancel the reset. 
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TEAM 521A Diagnostics Application

The TEAM 521A Diagnostics application provides a variety of tests to the SC521A DSU. Test
involve just the local DSU, or the local and remote DSUs and the telephone lines that connec

You can start the TEAM 521A Diagnostics application by either of two methods: 

• Select an SC 521A DSU symbol on the shelf submap in OpenView, then select the Diag
option from the Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Fault and select Diag
from the resulting menu. When the master or remote TEAM 521A Diagnostics window ap
(Figure 4-1), the read-only Name field displays the shelf and slot identification for the DS

  

Figure 4-1 SC521A Diagnostics Windows

The Diagnostics Menus and Display 

Both the Master and Remote Diagnostics windows contain the following functions: 

• A File menu contains Exit  for dismissing the window

• A Navigate menu contains History  for displaying test results accumulated during the curre
diagnostic session. The History option is described later in this chapter.

• A Selection panel contains buttons and check boxes for selecting, starting, and stopping
Three tests and four test pattern options are available. If a pattern cannot be combined 
particular test, it appears grayed-out.

• A Graphic panel depicts the path followed by test data during the current test. 

• A Time Blocks input field for specifying the duration of a test that employs the DSU test pa
generator.

• Time Remaining and Results displays. 
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Master SC521A Tests
The Master SC521A tests are utilized when the SC521A is a local device.  Table 4-2 describes the 
Master Diagnostics window and the available tests and patterns. Test procedures and diagr
follow the table. 

Note The remote DSU must have the RDL Initiation Sequence    option the same as the master DSU to b
able to accept the initiation sequence.

Table 4-2 Master SC521A Diagnostic Tests and Patterns

Test Description Patterns

Line Loop 
(with Pattern)

DSU initiates a local loopback and activates its own test 
pattern generator/checker. 

511 
2047 
15 bit 
None 

Remote Loop 
(with Pattern)

Local DSU commands the remote DSU into digital loopback 
and activates its own test pattern generator/checker (Point to 
Point circuit only). See note below.

Line Loop 
(without Pattern)

DSU initiates a local loopback, through which the DTE or external test 
equipment connected to the DTE interface can direct a test pattern. 
Must be ended by the Stop Test button. 

Remote Loop 
(without Pattern)

Local DSU commands the remote DSU to initiate a digital loopback. A test 
pattern from the local DTE or from external test equipment connected to the 
local DTE interface can then be directed through the resulting test path. 
Must be ended by the Stop Test button. See note below.

Data Loop Local DSU loops data it receives from the remote DSU back to the remote DSU. 
Must be ended by the Stop Test button. 

Note The Remote Loop test and the Remote Loop with Test Pattern test are only available in a Point to P
network and are used for unmanaged remote units. They are not compatible with a remote NMS 520
a remote NMS 510 or a remote SC 521A. You can achieve the same functionality with any of those
by directly commanding the remote unit into a digitial loopback.
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Master SC521A Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected DSU. 

1. Click on the check box next to the desired test. 

2. If you have selected Line Loop  or Remote Loop , you can perform the test either with an
internally generated test pattern or with externally generated and checked data. Under t
Pattern heading, click on 511, 2047, 15 Bit, or None (for external data).  Data Loop does
require a test pattern.

3. Select the desired number of blocks (1000 bits/block) to run during the test.

4. For internally generated test patterns, click the Start Test  button. While the test runs, the
graphic panel illustrates the data path employed by the test. The Time Remaining  field 
counts down from 100 to 0 percent, and the Test Duration  field displays how long the test
is to run. 

5. During a test with an internally generated test pattern, the Test Results field displays the
following prompts:

Running: ###  (### designates the number of errors detected)
In Loop   (displayed when external data is in use) 

6. During a test using an internally generated test pattern, the Time Remaining  field counts 
down from 100 to 0 percent, and the Test Duration  field displays how long the test is to 
run before ending automatically. 

7. For tests other without internally generated patterns, click on the Stop Test  button to end 
the procedure. The Stop Test button can also stop a test with test pattern prior to its auto
Test Time limit.

Special Considerations

• With a Master SC 521A, the Remote Loop tests are available for unmanaged units only.

• With a Master SC 521A/S in a Sink mode Point-to-Point circuit, the Remote Loop tests a
available for unmanaged units only.

• With a Master SC 521A/S in a Source mode Point-to-Point circuit, the Remote Loop tes
available whether or not the remote unit is managed or unmanaged.

• With a Master SC 521A/S in Source or Sink mode Multi-Point circuit, the Remote Loop t
are not available.
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Master SC521A Diagnostic Test Diagrams

Remote Loop

Only available for 
unmanaged Point To Point 
remotes (see Special 
Considerations )

Remote Loop with 
Pattern  

Only available for 
unmanaged Point To Point 
remotes (see Special 
Considerations )

Data Loop

Line Loop 
DTE and Network

Line Loop 
DTE only)

Line Loop with Pattern
DTE and Network 

Line Loop with Pattern
DTE only)
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The Remote SC521A tests are utilized when the SC521A or SC 521A/S is a remote device.
Table 4-3 describes the Master Diagnostics window and the available tests and patterns. Re
test procedures and diagrams follow the table.

Table 4-3 Remote Diagnostic Window

Test Description Patterns

Line Loop 
(with Pattern)

DSU initiates a local loopback at its network interface and activates 
its test pattern generator/checker. 511

2047
15 bit
None

End To End 
(with Pattern)

Remote SC521A DSU activates its test pattern generator/checker 
and transmits the pattern on its link to the master SC 521A DSU. 
Remote DSU checks for errors in the signal it receives, which is 
generated by the master DSU. 

Dataloop 
(with Pattern)

Remote SC521A DSU transmits the loopback command to the 
master SC 521A DSU, and activates its test pattern generator/
checker to transmit the pattern and check for errors in the signal it 
receives back. 

Dataloop 
(without Pattern)

Remote SC521A DSU transmits a command on the link that causes the master SC 
521A DSU to loop data back to the Remote DSU; DTE or external test equipment at 
the remote DSU is responsible for generating and checking a test pattern. 

Delay Test Not supported.
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Remote SC521A Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected DSU. 

1. Click on the check box next to the desired test. 

2. If you have selected Line Loop  or  End to End , you can perform the test either with an
internally generated test pattern or with externally generated and checked data. Under t
Pattern heading, click on 511, 2047, 15 Bit, or None (for external data).  Delay Test and 
dataloop do not require test patterns. 

3. Select the desired number of blocks (1000 bits/block) to run during the test.

4. For internally generated test patterns, click the Start Test  button. While the test runs, the
graphic panel illustrates the data path employed by the test. The Time Remaining  field 
counts down from 100 to 0 percent, and the Test Duration  field displays how long the test
is to run. 

5. During a test with an internally generated test pattern, the Test Results field displays the
following prompts:

Running: ###  (### designates the number of errors detected)
In Loop   (displayed when external data is in use) 

6. During a test using an internally generated test pattern, the Time Remaining  field counts 
down from 100 to 0 percent, and the Test Duration  field displays how long the test is to 
run before ending automatically. 

7. For tests other without internally generated patterns, click on the Stop Test  button to end 
the procedure. The Stop Test button can also stop a test with test pattern prior to its auto
Test Time limit.

Note Before running a Data Loop test on a remote, make sure the Remote Rsp Interval is 
Disabled at the Network Option window. 
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Remote SC521A Diagnostic Test Diagrams

Data Loop

Data Loop with Pattern

Delay 

End to End

Line Loop with Pattern 
DTE and Network

Line Loop with Pattern 
DTE only
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TEAM 521A Diagnostics History 
From the Diagnostics Navigate menu, you can select the History option, which displays five
columns of test records from all tests run during the current diagnostic session (Figure 4-2).

Figure 4-2 Diagnostics History Window

During an on-going diagnostic session you can close and re-open the Diagnostics History w
without loss of display data. Test Results can appear as follows:

To close the Diagnostics History window, click on either the OK button or the pushpin icon in the
upper left corner of the window. The application clears the Diagnostics History when you exit
the Diagnostics window. 

Test Result Description

Idle: n/n Bit/Block Errors Indicates a completed test with test pattern

Not in loop [STOPPED] Indicates a completed loop test without test pattern

Test Stopped Indicates any test with test pattern that was ended by 
the Stop Test button

n ms Indicates a Delay test
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Chapter 5: NMS 520

Overview

The SC 521A Data Service Unit (DSU) can operate in conjunction with an NMS 520 DSU loc
at a remote site. The TEAM 521A software supports a full range of functions for the remote 
520 DSU, as it does for the SC 521A DSU. This chapter describes NMS 520 functionality an
operation. Throughout the text descriptions in this chapter, keypresses and default values w
shown in Bold. Accompanying screens are representative and may appear differently on you
system.

Access to the NMS 520 Functions

Access to the NMS 520 functions takes place through the icon for the SC 521A DSU that is 
to the NMS 520 DSU that you intend to work with. 

1. Display the shelf map. Any DSU that does not have an associated remote is identified by a b
around its icon symbol. Each DSU that has an associated remote is identified by an icon
symbol without a box.

2. Double click on the icon symbol of the DSU that is linked to the DSU you intend to wo
with. The application responds by opening a submap that displays icons for the two DSU
a connecting line to indicate that together they form a link.

3. From this submap you can either click once on the DSU icon to select it and then acces
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 520 Front Panel display window. From the Front Panel display you can a
NMS 520 functions through Select button menus.

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 521A DSU and the remote NMS 520 DSU is configured to be DDS II
secondary channel.

When the link is configured for DDS I or for Clear Channel, the management communicatio
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput.

Note Reduction in throughput caused by management communications is most noticeable when the Fron
Panel display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate se
selected for Auto Poll, the greater the effect on user data.
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Submap Window Menu Bar Access

The following table illustrates how the NMS 520 functions of the TEAM 521A application are
arranged on the menu bar at the top of the HPOV link submap window. You must click on the
icon to select it before you open the menu you intend to use.The table below shows only the
selections for the NMS 520 functions. The submap window menus include other selections 
the window is accesses other applications.

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel in the Performance menu and the two items in th
menu.

NMS 520 DSU Front Panel
The NMS 520 Front Panel window (See Figure 5-1 and Figure 5-2) provides a graphical interface
to a remote NMS 520 DSU. You can launch a Front Panel from the link submap, described 
under the heading Access to the NMS 520 Functions, in either of two ways:

• select the NMS 520 icon in the submap window, then select Front Panel from the 
Performance menu for the window.

• double click the mouse on the NMS 520 icon.

The application responds by displaying a window that depicts the front panel of the selected
520 DSU unit. There are two NMS 520 DSU Front Panel displays, one for the model with 
Intelligent Front Panel (IFP) and one for the model without IFP.

Menu Bar Menu Selections

Performance Front Panel...

Alarms...

DTE Status...

Line Statistics...

Configuration Configure...

Maintenance...

Fault Diagnose...

Misc Front Panel Poll Rate...

Note Pad 
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Figure 5-1 NMS 520 IFP DSU Front Panel

Figure 5-2 NMS 520 Non-IFP DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical uni

• NS – No Signal indicates when lit that there is no signal at the network interface of
remote DSU

• SD – Send Data indicates when lit that the DSU is transmitting data

• RD – Receive Data indicates when lit that the DSU is receiving data

• RS – Request to Send indicates when lit that the DTE has data to transmit

• CS – Clear to Send indicates when lit that the DSU is prepared to transmit data

• CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its net
interface

• TR – Terminal Ready indicates when lit that the DTE is powered on

• NORM – DSU mode indication, when lit indicates DSU in normal mode; when off 
indicates DSU in diagnostic mode

• TEST/OK – indicates when lit that the DSU is receiving valid test data

• DBU – not a valid indicator in the TEAM application environment

• NETCON CO – not a valid indicator in the TEAM application environment

• NETCON DATA – not a valid indicator in the TEAM application environment

• NETCON RESP – not a valid indicator in the TEAM application environment

• NETCON TEST – not a valid indicator in the TEAM application environment

The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled.
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The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 521A application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the submap window menu bar.

The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display.

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll.

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu.

The menu selection Exit dismisses the Front Panel window when you click on it.

Performance Functions

Alarms

You can launch the NMS 520 Alarm Detail application from the submap Performance Menu
from the front panel menu. The application displays the read-only Alarm Detail window for th
selected DSU (See Figure 5-3). The TEAM 521A application polls the DSU for changes in alar
conditions.

Select Menu Items Selections

Performance Alarms...

DTE Status...

Line Statistics...

Configuration Configure...

Maintenance...

Fault Diagnose...

Demand Poll

Auto Poll 15 seconds

30 seconds

60 seconds

Disable

Exit
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Figure 5-3 Alarm Detail Window

Major Alarms

• EEPROM Checksum – indicates that the non-volatile memory that stores the DSU
configuration has become corrupted

• No Signal – indicates no signal at the DSU network interface

• Line Pairs Reversed – indicates line pairs reversed at network interface

• Streaming – indicates constant RTS condition at the DTE interface

• DTP Loss – indicates loss of Data Terminal Power

• DCD Loss – indicates loss of Data Carrier Detect

• DCD Shorted – indicates Data Carrier Detect lead shorted to ground

• CTS Shorted – indicates Clear To Send lead shorted to ground

• RXD Shorted – indicates Receive Data lead shorted to ground

• RXC Shorted – indicates Receive Timing lead shorted to ground

• TXC Shorted – indicates Transmit Timing lead shorted to ground Frame Loss – indi
loss of framing

• No DSU Response – indicates the remote DSU does not respond to polling by the m
unit (valid only in DDS I operation)
076R154-V400 TEAM 521A Version 4.0.0 5-5
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• No DTE Polling – indicates the DTE connected to the remote DSU does not respo
polling by the master unit (valid only in DDS I operation)

Minor Alarms

• No Loop Current – indicates no current at network interface

• TM Shorted – indicates Test Mode lead shorted to ground

• RXD Loss – indicates loss of Receive Data

• DSR Shorted – indicates Data Set Ready lead shorted to ground

• Bipolar Violation – indicates excessive Bipolar Violations in received signal

• Jitter – indicates excessive Jitter in received signal

• Signal To Noise – indicates poor signal to noise ratio in received signal

• Rx Signal Low – indicates weak received signal

Informational Alarms

• Front Panel Test – indicates the DSU has been commanded into a test mode by m
its front panel switches

• DSR Loss – indicates loss of Data Set Ready

• DTR Loss – indicates loss of Data Terminal Ready

• TXD Loss – indicates no transmit data from the DTE

• STC Loopback – indicates the DSU has been commanded into a test mode by the
Serving Test Center (STC)

Alarm Detail Window Menus

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display.

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled.

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display.

DTE Status

You can launch the NMS 520 DTE Status application from the submap Performance Menu o
the front panel menu. The application displays the read-only DTE Status window for the sel
DSU (Figure 5-4). The window displays indicators for the states of the EIA signals at the DTE
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions.

Status Window Menu

The Status window has a File menu with the selections Demand Poll, Auto Poll, and Exit.
5-6 TEAM 521A Version 4.0.0 076R154-V400
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Selecting Demand Poll causes an immediate update of the display.

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled.

Figure 5-4 DTE Status Window
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Line Statistics

You can launch the Line Statistics application from the submap Performance Menu or from 
front panel menu. As shown in Figure 5-5, the application displays nine categories of line 
performance statistics accumulated by the unit over the most recent 15 minutes. The statist
displayed on 15 lines, each representing one minute of the displayed interval. The Minute In
column simply identifies the time frame for the other eight items in the row.

The Status column can display Normal or No Signal. The Transmit Level and Receive Leve
columns display the strength, in decibels, of the signals being sent and received by the DSU
Signal to Noise Ratio column indicates the extent to which useful signal exceeds incidental 
The Signal Quality column indicates the overall condition of the signal being received during
minute. The Phase Jitter column displays the percentage by which phase shift in the received
exceeds acceptable levels. BPV Count displays the number of instances that occurred durin
minute when consecutive ones in the signal being received did not alternate states, thus cons
a bipolar violation. The Frame Loss column displays the number of times during the minute 
framing bits could not be identified.

Line Statistics Window Menus

The Line Statistics window has a File menu that consists of Refresh and Exit selections. Th
Refresh selection causes the window to display the latest available data. The window is not
dynamic display, so you should use the Refresh selection occasionally when you keep the w
open for long periods. The Exit selection dismisses the Line Statistics window.

Figure 5-5 Line Statistics Window
5-8 TEAM 521A Version 4.0.0 076R154-V400
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Configuration Functions – Configure

You can launch the NMS 520 Configuration function from the submap Configuration Menu or 
the front panel menu. When you launch the window, it initially displays the read-only NMS 5
Configuration window, which has a File menu and a Navigate menu in its menu bar.

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window.

The Navigate menu accesses the four read/write windows for configuring DSU operation by m
of System Options, Network Options, DTE Options, and Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate. From the Navigate 
menu you select the individual configuration windows in which you make changes. The File menu 
commands the storage and retrieval of configuration settings. 

Menu Buttons Menu Selections
Further 

Selections

File Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 
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Main Configuration Window Read-Only Display

Figure 5-6 Main Configuration Window

System Options

The NMS 520 System Options configuration window 
contains three options: 

Alarm Scan – permits you to Enable or Inhibit alarm trap 
generation by the SCM. 

Front Panel – permits you to disable the switches on the 
front panel of the DSU as protection against any inadvertent 
interruption of its operation.  Options are:

• Enable – DSU front panel switches are operational. 

• Disable – DSU front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. 

• 2, 4, 6, 8 seconds

Name: Shelf and slot identification for the master DSU followed by the 
slot:line:drop address of the remote NMS 520 DSU

Serial Number: Displays the serial number of the NMS 520 DSU

Firmware Revision: Displays the revision level of the NMS 520 DSU operating code 
(minimum required for compatibility: L-) 

DDS MIB Version: Displays the revision level of the MIB files that enable SNMP control 

NMS 520 MIB Version: Displays the revision level of the MIB files that enable SNMP control 
5-10 TEAM 521A Version 4.0.0 076R154-V400
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NMS 520 Network Options

The NMS 520 Network Options configuration window appears when you select Network Op
from the Main Configuration window Navigate menu. Network and Circuit Parameters are 
described below.

Figure 5-7 NMS 520 Network Options Configuration Window

Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected. 
Options are:

• Clear Channel 

• DDS-I 

• DDS-SC 

Carrier – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU. Options are:

• Tx Constant, Rx Constant – for use on a point-to-point circuit 

• Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-po
circuit 

• Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-poin
circuit 

• Tx Switched, Rx Switched – for use when required by specialized applications

Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in
the DSU. Options are:

• 2.4 Kbps - Async 

• 2.4 Kbps - Sync 

• 4.8 Kbps - Async 
076R154-V400 TEAM 521A Version 4.0.0 5-11
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• 4.8 Kbps - Sync 

• 9.6 Kbps - Async 

• 9.6 Kbps - Sync 

• 19.2 Kbps - Async 

• 19.2 Kbps - Sync 

• 56 Kbps - Sync 

• 64 Kbps - Sync 

Circuit Parameters

Tx Clock Source – displays the source of transmit timing for the DSU; this item is read only 
grayed out. Options are:

• Receive – transmit timing based on receive data timing

• Internal – transmit timing provided by the DSU internal clock 

• External – transmit timing provided by the DTE; the Buffer Clock option is forced to
External and cannot be changed when this is selected 

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE . Op

• Internal  – selects timing provided by the DSU internal clock 

• External – selects timing provided by the DTE; when External is selected for Tx Cl
Source this selection is forced and cannot be changed 

Zero Encoding – selects Zero Encoding, which 56 kbps DDS-SC applications require to ensu
primary and secondary channels do not transmit all spaces (zeros) at the same time. Option

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth 

• Disable – DSU does not prevent the all space condition 

Sentry Timer – selects the minimum time interval permitted between alarm reports in a DDS
clear channel point-to-point link; setting configured here must match that in the SC 521A DS
Options:

• Disable 

• 1 Minute to 5 Minutes – in one minute increments

• 10 Minutes 

• 15 Minutes to 60 Minutes – in 15 minute increments 

• 60 Minutes

• 90 Minutes

• 120 Minutes 
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Rmt Rsp Interval – selects the minimum time interval permitted between alarm reports in a D
multi-point link; SC 521A DSU and all remote NMS 520 DSUs must be configured to the sa
setting. Options:

• Disable 

• 10 Seconds

• 10 Seconds to 120 Seconds – in ten second increments 

Alarm Hysteresis – selects the minimum time an alarm condition must persist in order to be
reported. Options:

• 10 Seconds to 120 Seconds – in ten second increments 

• 10 Seconds

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it dete
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code. Options:

• Disable 

• Enable 

System Status – when this option is enabled the DSU clamps Data Set Ready when it detec
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code. Options:

• Disable 

• Enable 
076R154-V400 TEAM 521A Version 4.0.0 5-13
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DTE Options

The NMS 520 DTE Options configuration window contains four groups of options: Interface
Control Parameters, Async Parameters, and Diagnostic Parameters. 

Figure 5-8 DTE Options Configuration Window

Interface 

Interface Type – specifies the DTE port type. Options:

• RS232 – EIA/TIA-232-E interface 

• V.35 – ITU-T V.35 interface 

• Auto – the DSU automatically senses the interface type being used by the DTE 

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapter (
card installed. Options:

• None 

• Installed 

Data Type – selects the DSU to function with either synchronous or asynchronous data from
DTE; this option is available only for data rates of 19.2 kbps and less. Options:

• Sync 

• Async 
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Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled. Options: 

• Disable

• 5 Seconds

• 10 Seconds

• 30 Seconds

• 45 Seconds

Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
its DTE. Options: 

• Disable – switched DSR signal controlled by DTR 

• Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from th
and returning Clear To Send to the DTE. Options: 

• CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option o
Network Options configuration window

• Fixed 3 Char – equivalent to three character times 

• 0 msec 

• 30 msec 

• 60 msec 

• 90 msec 

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. Options are: 

• Disable – normal data 

• Enable – inverted data 

Note: IMPORTANT: Consider the following factors when you change the setting of this option: 

Set only this option and save the change to the unit. Do not combine it with other configuration chan

The HDLC option must be set the same at both ends of the link. Make changes at the remote DSU
before you change the option setting at the master DSU. Changing the option at the remote results
“SNMP ‘Set’ Request Failed” error message and causes loss of communication between the remote
master units. Click on OK in the error message box to dismiss the message, then proceed to chang
option setting at the master. Communication resumes when the option change goes into effect at th
ter unit.
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Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration. 

Character Size – selects the number of bits per asynchronous character, including start and s
Options: 

• 11 Bits 

• 10 Bits 

• 9 Bits 

• 8 Bits 

Overspeed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b
Options: 

• 1%

• 2.3%

Suppression – determines what actions the DSU takes concerning transmit and receive End
(EOT). Options: 

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals 

• Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert
at the end of transmissions 

• Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from
end of received signals 

• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals 

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS c
valid only when Data Rate in the Network Options screen is set to 2.4 Kbps - Async. Option

• Disable 

• 600 

• 1200 

• 1800 to 2400 

Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mod
Options:

• Off During LL Test 

• Normal – DSR operates in the same way that it is optioned to function during data m
operations 

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU o
loop transmit data back to the DTE, or also to loop receive data back to the network. Option

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only 

• Network & DTE – Line Loopback command causes DSU to loop data in both direc
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Alarms Reported

The NMS 520 Alarms Reported configuration window lets you configure which alarm condit
are to be reported for the DSU and which are not. Network, DTE, and Unit parameters are s
below. 

Figure 5-9 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options has a diamond-shaped selection field. Select or de-select individua
options by clicking on the appropriate fields. When selected, the flied is highlighted, indicatin
alarm to be reported. Two buttons above the option fields operate as follows: 

• Click on Report All  to highlight all the alarm option selection fields. 

• Click on Report None  to remove the highlight from all the alarm option selection fields.

Alarms Reported Buttons

Report All – unmasks all alarms.

Report None – masks all alarms.

OK – saves your changes and closes the window.

Reset – replaces the information in the fields with the most recently read information from the 
Note that this button does not initiate a read of information from the DSU.

Cancel – cancels your changes and closes the window.
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Network Alarms

Each Network alarm, when unmasked, requires you to specify a threshold against which it i
evaluated. 

Alarm Interval - determines the time span for threshold evaluation. Options:

• 1 min, 5 min, 10 min, 15 min 

Bipolar Violation - lets you mask or unmask Bipolar Violation (BPV) alarms. A network BPV
occurs when the signal the unit receives at its network interface does not alternate between
levels as required for Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8Z
data encoding. The alarm occurs when the number of Bipolar Violations in the received sign
during one Alarm Interval exceeds the selected threshold. Options:

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Jitter - lets you mask or unmask Jitter alarms. The alarm occurs when the percent of jitter in
received signal remains above the selected threshold for at least one Alarm Interval. Option

• 1%, 2%, 5%, 10%, 20%, 40%, 60%, 80%, 99% 

Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold. O

• 1, 2, 5, 10, 20, 40, 60, 80, 99 

Rx Signal Low - lets you mask or unmask Rx Signal Low alarms. The alarm occurs when th
strength of the received signal remains below the selected threshold for at least one Alarm In
Options:

• -50 dB, -40 dB, -30 dB, -20 dB, -10 dB, -5 dB, 0 dB, 6 dB 

Signal to Noise - lets you mask or unmask Signal to Noise Ratio alarms. The alarm occurs wh
ratio of signal to noise in the received signal remains poorer than the selected threshold for 
one Alarm Interval. Options:

• 0, 5, 10, 15, 20, 25, 30, 40, 50 

DTE

• DTP Loss – indicates loss of Data Terminal Power 

• DCD Loss – indicates loss of Data Carrier Detect 

• DSR Loss – indicates loss of Data Set Ready 

• DTR Loss – indicates loss of Data Terminal Ready 

• RxD Loss – indicates no receive data from the remote DSU 

• TxD Loss – indicates no transmit data from the DTE 

• TM Shorted – indicates a short circuit on the Test Mode interface lead 

• Streaming – indicates a streaming condition at the DTE interface 

• DCD Shorted – indicates a short circuit on the Data Carrier Detect interface lead 

• DSR Shorted – indicates short circuit on the Data Set Ready interface lead 

• CTS Shorted – indicates a short circuit on the Clear To Send interface lead 

• RxD Shorted – indicates a short circuit on the Receive Data interface lead 

• RxC Shorted – indicates a short circuit on the Receive Timing interface lead 

• TxC Shorted – indicates a short circuit on the Transmit Timing interface lead 
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• No Signal – indicates there is no signal at the DSU network interface 

• Line Pairs Reversed – indicates the transmit and receive line pairs are reversed 

• STC Loopback – indicates the DSU has been commanded into a test mode by the Telco S
Test Center (STC) 

• Front Panel Test – indicates the DSU has been commanded into a test mode by means
front panel switches

• No Loop Current – indicates that network sealing current is inadequate or absent 

• EEPROM Checksum – indicates Configuration Checksum error 

Configuration Functions – Maintenance

You can launch the NMS 520 Maintenance function from the submap Configuration Menu or
the front panel menu. The application displays one read/write window by which you can con
some aspects of DSU operation that fall outside the scope of the Configure application. 

The window title bar displays the function name, NMS 520 Maintenance. The Name field dis
the shelf name and the slot number of the master DSU followed by the slot:line:drop address
remote DSU. The File menu contains only the selection Exit, by which you can dismiss the wi

Maintenance Window Buttons

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset. 

Perform Soft Reset – causes the DSU to perform a reset and resume operation using its cur
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 5-10 Maintenance Window
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Diagnostics
You can launch the NMS 520 Diagnostics function from the submap Fault menu or from the
panel menu. The application displays one read/write window by which you can control a vari
test functions on the DSU. 

Beneath the menu bar and the Name field the Diagnostics window (See Figure 5-11) is divided into 
three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test 

• Duration and results panel – contains an input field for specifying how many blocks of da
use for a test that employs the DSU test pattern generator; displays Test Duration, Time
Remaining, and Test Results 

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 5-12) accumulated during the curren
diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and three Patterns y
select for those tests that employ the DSU test pattern generator. The panel also includes a
field for the User Defined test pattern, and two buttons: Start Test and Stop Test. 

The following Tests are available: 

• Line Loop (performed only with test pattern) 

• End To End (performed only with test pattern) 

• Dataloop (can be performed with or without test pattern) 

• Delay Test 

The Patterns are: 

• 511 bit 

• 2047 bit 

• 15 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test
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Figure 5-11 NMS 520 Diagnostics Window

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test pattern 
generator/checker.

End To End 
(with Pattern)

Remote NMS 520 DSU activates its test pattern generator/checker and 
transmits the pattern on its link to the master SC 521A DSU. Remote DSU 
checks for errors in the signal it receives, which is generated by the master 
DSU. 

Dataloop 
(without 
Pattern)

Remote NMS 520 DSU transmits a command on the link that causes the 
master SC 521A DSU to loop data back to the Remote DSU; DTE or external 
test equipment at the remote DSU is responsible for generating and checking 
a test pattern. 

Dataloop
(with Pattern)

Remote NMS 520 DSU transmits the loopback command to the master SC 
521A DSU, and activates its test pattern generator/checker to transmit the 
pattern and check for errors in the signal it receives back. 

Delay Test Remote NMS 520 DSU transmits and receives a test signal, which is looped 
back by the master SC 521A DSU; the Remote DSU measures the round trip 
time (delay). 
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test. If you are running the Delay Test, go to S

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data). 

3. If you are using an internally generated test pattern select, in the Test Blocks field, how 
data is to run before the test ends automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent. 

5. During a test that employs an internally generated test pattern the Test Results field disp
the number of errors detected; it displays In Loop when external data is in use. 

6. If you are using an internally generated test pattern, the test ends automatically when th
specified number of data blocks have run. For any other test, click on the Stop Test butto
end the procedure. 

Note Following any test except Dataloop a pop up window appears with the message Network element 
communication problem. Try again. 

The message results from the interruption caused by the test. Normal operation should resume whe
click on the OK box to dismiss the pop up.

Note Before running a Data Loop test on a remote, make sure the Remote Rsp Interval is Disabled at th
NMS520 Network options window.
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Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window. 

Figure 5-12 Diagnostics History

The Diagnostics History displays information in five columns:

• Start Time – date and time test began

• Test – name of the test

• Pattern – test pattern used for the test; N/A when internally generated pattern is not use

• Test Blocks – number of data blocks sent during the test, applies only to tests with test p

• Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data. The application clears the Diagno
History when you exit from the Diagnostics window.

Miscellaneous Functions
The submap Misc Menu has selections for Front Panel Poll Rate and Note Pad. These sele
access the same applications that are described in Chapter 2. 
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Chapter 6: NMS 510

Overview

The SC 521A Data Service Unit (DSU) can operate in conjunction with an NMS 510 DSU loc
at a remote site. The TEAM 521A software supports a full range of functions for the remote 
510 DSU, as it does for the SC 521A DSU. This chapter describes the NMS 510 functionality 
software and provides instructions for its use. Throughout the text descriptions in this chapt
keypresses and default values will be shown in Bold. Accompanying screens are representative a
may appear differently on your system.

Access to the NMS 510 Functions

Access to the NMS 510 functions takes place through the icon for the SC 521A DSU that is 
to the NMS 510 DSU that you intend to work with.

1. Display the shelf map. Any DSU that does not have an associated remote is identified by a b
around its icon symbol. Each DSU that has an associated remote is identified by an icon
symbol without a box.

2. Double click on the icon symbol of the DSU that is linked to the DSU you intend to work w
The application responds by opening a submap that displays icons for the two DSUs wit
connecting line to indicate that together they form a link.

3. From this submap you can either click once on the DSU icon to select it and then acces
functions through the menu bar of the submap window, or double click on the DSU icon 
open the NMS 510 Front Panel display window. From the Front Panel display you can a
NMS 510 functions through Select button menus.

Master/Remote Communications

Management communications take place on the secondary channel when the link between 
master SpectraComm 521A DSU and the remote NMS 510 DSU is configured to be DDS II
secondary channel.

When the link is configured for DDS I or for clear channel the management communications
occupy the same channel that carries user data. When that is the case, each management 
communication has the effect of briefly interrupting or causing errors in the user data. Error 
correcting protocols and requests for retransmission protect user data against corruption, bu
effect does slightly reduce throughput.

Note Reduction in throughput caused by management communications is most noticeable when the Fron
Panel display or the Alarm Detail window is open with Auto Poll enabled. The faster the scan rate se
selected for Auto Poll, the greater the effect on user data.
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Submap Window Menu Bar Access
The table on the following page illustrates how the NMS 510 functions of the TEAM 521A 
application are arranged on the menu bar at the top of the HPOV link submap window. The
shows only the menu selections for the NMS 510 functions. The submap window menus wi
include other selections, since the window is accessible to other applications.

You must click on the DSU icon to select it before you open the menu you intend to use.

The Performance menu Front Panel selection opens the Front Panel display window, which
provides access to menus through its Select button. All the menu selections shown above ap
the Select button menus except Front Panel in the Performance menu and the two items in th
menu.

Menu Bar Menu Selections

Performance Front Panel...

Alarms...

DTE Status...

Configuration Configure...

Maintenance...

Fault Diagnose...

Misc Front Panel Poll Rate...

Note Pad
6-2 TEAM 521A Version 4.0.0 076R154-V400
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NMS 510 DSU Front Panel

The NMS 510 Front Panel display window (See Figure 6-1) provides a graphical interface to a 
remote NMS 510 DSU. You can launch a Front Panel from the link submap, described above
the heading Access to the NMS 510 Functions, in either of two ways:

• select the NMS 510 icon in the submap window, then select Front Panel from the Perform
menu for the window

• double click the mouse on the NMS 510 icon.

The application responds by displaying a window that depicts an NMS 510 DSU. The applic
employs the same display regardless of whether or not the selected DSU is equipped with a
Intelligent Front Panel (IFP).

Figure 6-1 NMS 510 DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical uni

• NS – No Signal indicates when lit that there is no signal at the network interface of
remote DSU

• SD – Send Data indicates when lit that the DSU is transmitting data

• RD – Receive Data indicates when lit that the DSU is receiving data

• RS – Request to Send indicates when lit that the DTE has data to transmit

• CS – Clear to Send indicates when lit that the DSU is prepared to transmit data

• CO – Carrier On indicates when lit that the DSU is receiving a carrier signal at its net
interface

• TR – Terminal Ready indicates when lit that the DTE is powered on

• NORM – DSU mode indication, when lit indicates DSU in normal mode; when off 
indicates DSU in diagnostic mode

• TEST/OK – indicates when lit that the DSU is receiving valid test data

• DBU – not a valid indicator in the TEAM application environment

• NETCON CO – not a valid indicator in the TEAM application environment

• NETCON DATA – not a valid indicator in the TEAM application environment

• NETCON RESP – not a valid indicator in the TEAM application environment

• NETCON TEST – not a valid indicator in the TEAM application environment

The application polls the DSU to keep the states of the LEDs in the Front Panel display curren
time of the most recent poll appears in the bottom left corner of the Front Panel display. The
is displayed in white when Auto Poll is enabled, and in yellow when it is disabled.
076R154-V400 TEAM 521A Version 4.0.0 6-3
Issue 1 Operation Manual



NMS 510 Performance Functions

MS 510 
elect 

ew 

omatic 
ED 
nt 

 Panel 

 or 
the 
m 
The Select button on the Front Panel displays provides access to menus for the rest of the N
functions of the TEAM 521A application. The following table shows the arrangement of the S
button menus. It differs somewhat from the arrangement on the submap window menu bar.

The two Poll selections in the Select button menu determine when the application collects n
information from the DSU to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display.

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Front Panel window displays a static snapshot of the L
states as they were at the last poll, either when the window was launched or a subseque
Demand Poll.

Each time the Front Panel display is opened, its initial polling rate is determined by the Front
Poll Rate selection of the HPOV map window Misc menu.

The menu selection Exit dismisses the Front Panel window when you click on it.

Performance Functions

Alarms

You can launch the NMS 510 Alarm Detail application from the submap Performance Menu
from the front panel menu. The application displays the read-only Alarms Detail window for 
selected DSU (See Figure 6-2). The TEAM 521A application polls the DSU for changes in alar
conditions.

Select Menu Items Selections

Performance Alarms...

DTE Status...

Configuration Configure...

Maintenance...

Fault Diagnose...

Demand Poll

Auto Poll 15 seconds

30 seconds

60 seconds

Disable

Exit
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Figure 6-2 Alarm Detail Window

Major Alarms

• EEPROM Checksum – indicates that the non-volatile memory that stores the DSU 
configuration has become corrupted

• DTP Loss – indicates loss of Data Terminal Power

• DCD Loss – indicates loss of Data Carrier Detect

• No Signal – indicates no signal at the DSU network interface

• Streaming – indicates constant RTS condition at the DTE interface

• Frame Loss – indicates loss of framing

Minor Alarm

• RXD Loss – indicates loss of Receive Data

Informational Alarms

• Front Panel Test – indicates the DSU has been commanded into a test mode by means
front panel switches

• DSR Loss – indicates loss of Data Set Ready

• DTR Loss – indicates loss of Data Terminal Ready
076R154-V400 TEAM 521A Version 4.0.0 6-5
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• TXD Loss – indicates no transmit data from the DTE

• STC Loopback – indicates the DSU has been commanded into a test mode by the Telco S
Test Center (STC)

Alarm Detail Window Menus

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Demand
causes an immediate update of the display.

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condition
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled.

The View menu consists of three selections: Major, Minor, and Informational, each with a ch
box beside it. To remove an alarm category from the window display, click on its check box s
it is unchecked. Clicking a box so that it is checked restores the corresponding category to t
display.

DTE Status

You can launch the NMS 510 DTE Status application from the submap Performance Menu o
the front panel menu. The application displays the read-only DTE Status window for the sel
DSU (See Figure 6-3). The window displays indicators for the states of the EIA signals at the D
interface. Dark green indicates Off, light green indicates On, and light green with a superimp
two-headed arrow indicates transitions.

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto Po
Exit.

Selecting Demand Poll causes an immediate update of the display.

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable, the Status window displays a static snapshot of the EIA indicat
they were at the last poll, either when the window was launched or a subsequent Demand P

The time of the most recent poll appears in the bottom left corner of the window. The time is
displayed in white when Auto Poll is enabled, and in yellow when it is disabled.
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Figure 6-3 DTE Status Window

Configuration Functions – Configure

You can launch the NMS 510 Configure function from the submap Configuration Menu or from
front panel menu. When you launch the window, it initially displays the read-only NMS 510 
Configuration window, which has a File menu and a Navigate menu in its menu bar.

The File menu contains the selections

• Refresh, which discards all unsaved changes and restores all options in the displayed 
configuration windows to the values they are assigned by the current operating configur

• Save to Unit, which puts the new configuration into use by the DSU

• Load Template, by which you can recall a stored configuration template that you can then
to the DSU either with or without modifications

• Save to Template, by which you can store the current configuration on the workstation f
future use as a template

• Compare to Template, by which you can identify differences between the configuration 
displayed on-screen and a selected template

• Exit, by which you can dismiss the window.
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The Navigate menu enables you to access the four read/write windows by which you can con
various aspects of DSU operation:

• System Options

• Network Options

• DTE Options

• Alarms Reported

• All Screens

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSU. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu commands 
the storage and retrieval of configuration settings. The contents of the two menus appear be

Menu Buttons Menu Selections
Further 

Selections

File Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate System Options... 

Network Options... 

DTE Options... 

Alarms Reported... 

All Screens... 
6-8 TEAM 521A Version 4.0.0 076R154-V400
Operation Manual Issue 1



NMS 510 Configuration Functions – Configure

against 

 it 
Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Figure 6-4 Main Configuration Window

System Options

The NMS 510 System Options configuration window contains two options.

Figure 6-5 NMS 510 System Options Configuration Window

Front Panel – permits you to disable the switches on the front panel of the DSU as protection 
any inadvertent interruption of its operation. Options:

• Enable – DSU front panel switches are operational.

• Disable – DSU front panel switches are disabled.

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU before
declares a No Response condition. Options:

• 2, 4, 6, 8 seconds

Name: shelf and slot identification for the master DSU followed by the 
slot:line:drop address of the remote NMS 510 DSU

Serial Number: displays the serial number of the NMS 510 DSU

Firmware Revision: displays the revision level of the NMS 510 DSU operating code

DDS Version: displays the revision level of the MIB files that enable SNMP control

NMS 510 MIB Version: displays the revision level of the MIB files that enable SNMP control
076R154-V400 TEAM 521A Version 4.0.0 6-9
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NMS 510 Network Options

The NMS 510 Network Options configuration window (Figure 6-6) appears when you select 
Network Options from the Main Configuration window Navigate menu. The window contains
panels labeled Network Parameters and Circuit Parameters.

Figure 6-6 NMS 510 Network Options Configuration Window

Network Parameters

Line Type – read-only field displays the type of service to which the DSU is connected. Opti

• Clear Channel

• DDS-I

• DDS-SC

Carrier – selects the combination of transmit and receive carrier modes (constant/switched)
used by the DSU. Options:

• Tx Constant, Rx Constant – for use on a point-to-point circuit

• Tx Constant, Rx Switched – for use when the DSU is the master unit on a multi-po
circuit

• Tx Switched, Rx Constant – for use when the DSU is a remote unit on a multi-poin
circuit

• Tx Switched, Rx Switched – for use when required by specialized applications
6-10 TEAM 521A Version 4.0.0 076R154-V400
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Data Rate – read-only field displays the data rate and mode (synchronous/asynchronous) in
the DSU. Options:

• 2.4 Kbps - Async

• 2.4 Kbps - Sync

• 4.8 Kbps - Async

• 4.8 Kbps - Sync

• 9.6 Kbps - Async

• 9.6 Kbps - Sync

• 19.2 Kbps - Async

• 19.2 Kbps - Sync

• 56 Kbps - Sync

• 64 Kbps - Sync

Circuit Parameters

Tx Clock Source – displays the source of transmit timing for the DSU; this item is read only 
grayed out. Options:

• Receive – transmit timing based on receive data timing

• Internal – transmit timing provided by the DSU internal clock

• External – transmit timing provided by the DTE; the Buffer Clock option is forced to
External and cannot be changed when this is selected

Buffer Clock – selects the source of timing for the buffer between the DSU and its DTE. Opt

• Internal  – selects timing provided by the DSU internal clock

• External – selects timing provided by the DTE; when External is selected for Tx Cl
Source this selection is forced and cannot be changed

Zero Encoding – selects Zero Encoding, required for 56 kbps DDS-SC applications in which
primary and secondary channels are not permitted to transmit all spaces (zeros) at the sam
Options:

• Enable – DSU prevents the all space condition at the expense of reduced seconda
channel bandwidth

• Disable – DSU does not prevent the all space condition

Circuit Assurance – when this option is enabled the DSU clamps Clear To Send when it dete
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code. Options:

• Disable

• Enable

System Status – when this option is enabled the DSU clamps Data Set Ready when it detec
of the following conditions: Idle, Out of Service, No Signal, Abnormal Station Code, or Inact
Channel Code. Options:

• Disable

• Enable
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DTE Options

The NMS 510 DTE Options configuration window contains four groups of options: Interface
Control Parameters, Async Parameters, and Diagnostic Parameters.

Figure 6-7 DTE Options Configuration Window

Interface

Interface Adapter – read-only field displays whether or not the DSU has a Data Rate Adapter (
card installed. Options:

• None

• Installed

Data Type – selects the DSU to function with either synchronous or asynchronous data from
DTE; this option is available only for data rates of 19.2 kbps and less. Options:

• Sync

• Async

Control Parameters

AAS – selects whether or not the DSU provides Automatic Anti-Streaming protection, and the
limit it enforces when the feature is enabled. Options:

• Disable

• 5, 10, 30, 45 Seconds
6-12 TEAM 521A Version 4.0.0 076R154-V400
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Constant DSR – selects the DSU to output either a constant or a switched Data Set Ready s
its DTE. Options:

• Disable – switched DSR signal controlled by DTR

• Enable – constant DSR signal

CTS Delay – selects the delay (if any) between the DSU receiving Request To Send from th
and returning Clear To Send to the DTE. Options:

• CTS ON – no delay; grayed out when Tx Constant is selected in the Carrier option o
Network Options configuration window

• Fixed 3 Char – equivalent to three character times

• 0, 30, 60, 90 msec

HDLC Invert – selects whether or not the DSU uses inverted channel data from the DTE. D
inversion is used primarily with DDS-SC 56 kbps circuits, to enhance data quality in a networ
does not provide B8ZS coding. Options are:

• Disable – normal data

• Enable – inverted data. 

Async Parameters

The Async Parameters options are grayed out when a synchronous Data Rate is selected in
Network Interface configuration.

Character Size – selects the number of bits per asynchronous character, including start and s
Options:

• 11 Bits

• 10 Bits

• 9 Bits

• 8 Bits

Overspeed – selects the percentage above its configured normal operating rate at which the
can accommodate receive data. It performs the over speed compensation by shaving stop b
Options:

• 1%

• 2.3%

Note: IMPORTANT: Consider the following factors when you change the setting of this option:

Set only this option and save the change to the unit. Do not combine it with any other configuration
changes.

The HDLC option must be set the same at both ends of the link. Make changes at the remote DSU
before you change the option setting at the DSE. Changing the option at the remote results in an “S
‘Set’ Request Failed” error message and causes loss of communication between the remote and m
units. Click on OK in the error message box to dismiss the message, then proceed to change the o
setting at the master. Communication resumes when the option change goes into effect at the mast
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Suppression – determines what actions the DSU takes concerning transmit and receive End
(EOT). Options:

• Disable – the DSU does not insert EOT at the end of transmissions, and does not d
it from the end of received signals

• Rx EOT – the DSU deletes EOT from the end of received signals; it does not insert
at the end of transmissions

• Tx EOT – the DSU inserts EOT at the end of transmissions; it does not delete it from
end of received signals

• Rx + Tx EOT – the DSU inserts EOT at the end of transmissions, and deletes it from
end of received signals

Rate Adaption – specifies the DTE interface operating rate when it is below that of the DDS c
valid only when Data Rate in the Network Options screen is set to 2.4 Kbps - Async. Option

• Disable

• 600

• 1200

• 1800 to 2400

Diagnostic Parameters

Data Set Ready – selects how the DSU controls the DSR output to the DTE during test mod
Options:

• Off During LL Test

• Normal – DSR operates in the same way that it is optioned to function during data m
operations

Line Loopback Test Points – selects whether a Line Loopback command causes the DSU o
loop transmit data back to the DTE, or also to loop receive data back to the network. Option

• DTE Only – Line Loopback command causes DSU to loop data back to DTE only

• Network & DTE – Line Loopback command causes DSU to loop data in both direc
6-14 TEAM 521A Version 4.0.0 076R154-V400
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Alarms Reported

The NMS 510 Alarms Reported configuration window (Figure 6-8) lets you configure which alarm
conditions are to be reported for the DSU and which are not. The window contains three pa
labeled Network, DTE, and Unit as shown below.

Figure 6-8 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selection
located to its left. You can select or de-select individual alarm options by simply clicking the m
button on the appropriate selection fields. When an option is selected for its alarm to be rep
its selection field is highlighted. The selection fields next to alarm options that are not to be rep
are not highlighted.

The Alarms Reported configuration window has two buttons positioned above the option fie
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields.

• Click on Report None to remove the highlight from all the alarm option selection fields.

After clicking Report All or Report None you can change the state of individual fields as nee

Alarms Reported Buttons

Report All – unmasks all alarms.

Report None – masks all alarms.
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Issue 1 Operation Manual



NMS 510 Configuration Functions – Configure

DSU. 

r 

ber of 
ptions:

erving 

 of its 
Reset – replaces the information in the fields with the most recently read information from the 
Note that this button does not initiate a read of information from the DSU.

OK – saves your changes and closes the window.

Cancel – cancels your changes and closes the window.

Network

Frame Loss is the one Network alarm. When it is unmasked you must specify a threshold fo
evaluating the alarm condition.

Alarm Interval - determines the time span for threshold evaluation. Options:

• 1 min, 5 min, 10 min, 15 min 

Frame Loss - lets you mask or unmask Frame Loss alarms. The alarm occurs when the num
lost frames in the received signal during one Alarm Interval exceeds the selected threshold. O

• 1, 2, 5, 10, 20, 40, 60, 80, 99

DTE

• DTP Loss – indicates loss of Data Terminal Power

• DCD Loss – indicates loss of Data Carrier Detect

• DSR Loss – indicates loss of Data Set Ready

• DTR Loss – indicates loss of Data Terminal Ready

• RXD Loss – indicates no receive data from the remote DSU

• TXD Loss – indicates no transmit data from the DTE

• Streaming – indicates a streaming condition at the DTE interface

Unit

• No Signal – indicates no signal at the DSU network interface

• STC Loopback – indicates the DSU has been commanded into a test mode by the Telco S
Test Center (STC)

• Front Panel Test – indicates the DSU has been commanded into a test mode by means
front panel switches

• EEPROM Checksum – indicates configuration checksum error
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Configuration Functions – Maintenance
You can launch the NMS 510 Maintenance function from the submap Configuration Menu or
the front panel menu. The application displays one read/write window by which you can con
some aspects of DSU operation that fall outside the scope of Configuration. See Figure 6-9.

The window title bar displays the function name, NMS 510 Maintenance. The Name field dis
the shelf name and the slot number of the master DSE followed by the slot:line:drop address
DSU. The File menu contains only the selection Exit, by which you can dismiss the window.

Maintenance Window Buttons

The Maintenance window provides the following two buttons.

Reset to Factory Defaults – causes all options in the DSU to return to their factory default settin
When you click on this button the application displays a warning “Resetting to factory defaults
terminate communications to the unit. Do you want to continue?” Click on the OK button in t
warning window to complete the reset, or click on the Cancel button to cancel the reset.

Perform Soft Reset – causes the DSU to perform a reset and resume operation using its cur
configuration. When you click on this button the application displays a warning “Performing a
reset will disrupt communications to the unit. Do you want to continue?” Click on the OK butto
the warning window to complete the reset, or click on the Cancel button to cancel the reset.

Figure 6-9 Maintenance Window
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Diagnostics
Launch the NMS 510 Diagnostics function from the submap Fault Menu or from the front pa
menu. The application displays one read/write window for controlling a variety of test function
the DSU.

Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window is divided into three area

• Selection panel – contains buttons and check boxes for selecting, starting, and stopping
functions

• Graphic panel – depicts the path followed by test data during the current test

• Duration and results panel – contains an input field for specifying how many blocks of da
use for a test that employs the DSU test pattern generator; displays Test Duration, Time
Remaining, and Test Results

The Diagnostics window menu bar contains File and Navigate. The File menu has only the 
selection by which you dismiss the window. The Navigate menu also has a single selection: H
by which you can access a display of test results (see Figure 6-11) accumulated during the curren
diagnostic session.

Tests

The following Tests are available:

• Line Loop (performed only with test pattern)

• End To End (performed only with test pattern)

• Dataloop (can be performed with or without test pattern)

• Delay Test

The Patterns are:

• 511 bit

• 2047 bit

• 15 bit

Each Test and Pattern is accompanied by a check box on which you can click to select it. The 
check boxes are grayed out when the selected Test cannot be combined with an internal test
6-18 TEAM 521A Version 4.0.0 076R154-V400
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Figure 6-10 NMS 510 Diagnostics Window

Diagnostics Overview

Test Description

Line Loop 
(with Pattern)

DSU initiates a loopback at its network interface and activates its test 
pattern generator/checker.

End To End 
(with Pattern)

DSU activates its test pattern generator/checker and transmits the 
pattern on its link to the DSE. DSU checks for errors in the signal it 
receives, which is generated by the DSE.

Dataloop 
(without 
Pattern)

DSU transmits a command on the link that causes the DSE to loop 
data back to the DSU; DTE or external test equipment at the DSU is 
responsible for generating and checking a test pattern.

Dataloop
(with Pattern)

DSU transmits the loopback command to the DSE, and activates its 
test pattern generator/checker to transmit the pattern and check for 
errors in the signal it receives back.

Delay Test DSU transmits and receives a test signal, which is looped back by the 
DSE; the DSU measures the round trip time (delay).
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Diagnostic Test Procedure

1. Click on the check box next to the selected test. If you are running the Delay Test, go to 

2. Under the Pattern heading, click on your selected pattern. The Dataloop test also suppo
selection None (for external data).

3. If you are using an internally generated test pattern select, in the Test Blocks field, how 
data is to run before the test ends automatically.

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the data 
employed by the test. If you are using an internally generated test pattern, the Time Rem
field counts down from 100 to 0 percent.

5. During a test that employs an internally generated test pattern the Test Results field disp
the number of errors detected; it displays In Loop when external data is in use.

6. If you are using an internally generated test pattern, the test ends automatically when th
specified number of data blocks have run. For any other test, click on the Stop Test butto
end the procedure.

Note Following any test except Dataloop a pop up window appears with the message Network element 
communication problem. Try again.

The message results from the interruption caused by the test. Normal operation should resume whe
click on the OK box to dismiss the pop up.
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Diagnostics History

You can view a record of tests performed during the current diagnostic session by selecting H
from the Navigate menu in the Diagnostics window. The record appears as a listing in the 
Diagnostics History window (see Figure 6-11).

Figure 6-11 Diagnostics History

The Diagnostics History displays information in five columns:

• Start Time – date and time test began

• Test – name of the test

• Pattern – test pattern used for the test; N/A when internally generated pattern is not use

• Test Blocks – number of data blocks sent during the test, applies only to tests with test p

• Test Results – “Idle: n/n Bit/Block Errors” for a completed test with test pattern; “Not in loo
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for any te
with test pattern that was ended by the Stop Test button; “n ms.” for Delay Test

To close the Diagnostics History window, click on either the OK button or the pushpin icon in
upper left corner of the window. During an on-going diagnostic session you can close and re
the Diagnostics History window without loss of display data.

The application clears the Diagnostics History when you exit from the Diagnostics window.

Miscellaneous Functions
The submap Misc Menu has selections for Front Panel Poll Rate and Note Pad. These sele
access the same applications that are described in Chapter 2, Operations. 
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